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NOTICE

GCC reserves the right to modify the information contained in this user
manual at any time without prior notice; un-authorized modification,
copying distribution or display is prohibited. All comments, queries or
suggestions concerning this manual please consult with your local dealer.
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Important Information

Thank you for purchasing the Expert Il Cutting Plotter.
Before you use the cutting plotter, please make sure that you have read the
safety precautions and instructions below.

JAN

Cauton SAFETY PRECAUTIONS!

> For safety concern, please always hold the cutter firmly from the bottom while moving

it. Do not move the cutter by clasping the depression area on both sides.

O (correct) X (Incorrect)

> Do not shake or drop the blade holder, a blade tip can fly out.

> During an operation, do not touch any of the moving parts of this machine (such as the
carriage). Also be careful to make sure that clothing and hair do not get caught.

> Always connect the power cable to a grounded outlet.

> Always use the accessory power cable which is provided. Do not wire the power cable
so that it becomes bent or caught between objects.

> Do not connect the power cable to branching outlet to which other machines are also
connected, or use an extension cable. There is danger of overheating and of
mis-operation of the machine.

> Keep the tools away from children where they can reach.

> Always put the pinch rollers within the white marks.

Important Information
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Chapter 1 General Information

1.1 Introduction

Expert |l series cutting plotters have been designed to produce computer-generated images
or perform contour cutting on sheets or rolls of vinyl media. In addition to performing quality
cutting on sheet or rolls of media, Expert Il series cutting plotters can also be used as a pen
plotter.

This manual covers the following models of Expert |l series cutting plotters:

Ex 1-24 for media width: 50mm(1.97”) ~ 719mm(28.3")

Ex 11-24LX for media width: 50mm(1.97”) ~ 719mm(28.3"), with AAS function
Ex 11-52 for media width: 50mm(1.97”) ~ 1470mm(57.9")

Ex 11-52LX for media width: 50mm(1.97”) ~ 1470mm(57.9”), with AAS function

1.2 Package Items
The package of Expert Il contents the items listed below, please check carefully.
If you find any item missing, please consult your local dealer for further assistance.

Item Quantity
Cutting Plotter 1 Set
Accessories 1 Set
AC Power Cord Desktop Support Brackets Cutting Pad

(EX 11-24/EX 11-24LX only)

<4

Cushion in tool carriage Tweezers

General Information 1-1



GCC..

Expert Il User Manual

1.3 Product Features
The followings are the main features of the Expert Il cutting plotters:
Dual-port connectivity — USB & Serial interface.
Up to 350 gram cutting force.
Up to 705 (EXII-24(LX) / 635 mm (EXII-52 (LX)) per second cutting speed
(at 45 degree direction.)
Guaranty 3 meter (10’) tracking.
Enhanced Automatic-Aligning System (AAS Il) for auto contour cutting
(only for LX models.)

1.4 The Appearance (EX Il)

141 The Front View

= L

H

D Figure 1-1

= S W . .
Object Description
A | Primary Pinch Roller To help hold the media during cutting.
B | Slicing Groove To help slice off media.
C | Alignment Ruler To align media with clear guideline marks
D | Tool Carriage Performs the cutting or plotting with the installed blade or
pen.
E | Blade Holder To hold the blade.
F | Platen The surface for holding and supporting media in operation.
G  Cutting Pad To protect blade and plate in operation.
H | Control Panel To consist of 10 control keys and 6 LED lights.
J | Grid Drum To move media back and forth in operation

General Information
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Figure 1-2
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Figure 1-3 Figure 1-4
Object Description
K | AC Power Connector To insert the AC power cord.
L | Fuse 3 Amp.
M | Power Switch To turn on or off the machine.
N | USB Connector To connect the machine and a computer through a
USB cable.
O | Serial Interface Connector | To connect the machine and a computer through a
RS-232 cable.

General Information 1-3
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Chapter 2 Installation

2.1 Precaution
Please read below information carefully before you start installation.

Notice 1
e Make sure the power switch is off before installing the cutting plotter.

e Carefully handle the cutter to prevent any injuries.

Notice 2 Choosing a proper place before setting up the cutting plotter

Before installing your cutting plotter, select a suitable location, which meets the following
conditions.

e The machine can be approached easily from any direction.

e Keep enough space for the machine, accessories and supplies.

e Keep the working area stable, avoiding severe vibration.

e Keep the temperature between 15 and 30 C (60-86°F) in the workshop.
e Keep the relative humidity between 25% and 75% in the workshop.

e Protecting the machine from dust and strong air current.

e Preventing the machine from direct sunlight or extremely bright lighting.

Notice 3 Connecting the Power Supply

Check the plug of the power cord to see if it mates with the wall outlet. If not, please contact
your dealer.

e Insert the plug (male) into a grounded power outlet.

e Insert the other end (female) of power cord into the AC connector of cutting plotter.

Notice 4 Tightening or Loosing Screws with Screwdriver

Whether manual or electric screwdriver, be careful not to use excess torque force when
tightening or loosing screws. When tightening or loosing iron and stainless steel screws,
please refer to the following screw torque standard table, other materials screws are not
included.

Installation 2-1



Expert Il User Manual

Screw Torque value (kgf-cm)
diameter Torque standard for high hardness materials
M3 6
M4 16
M5 30
M6 50

Installation

2-2



GCC.. Expert Il User Manual

2.2 Stand Installation
(Stand is an optional item for 24 inch models.)

2.21 Stand Installation
Please follow the procedures below for assembling the stand.

m Please examine the supplied items in the accessory box of the stand carton before

you install:

Stand is an optional item for Expert Il, Item List :
® 1 Left side vertical stand

1 Right side vertical stand

1 Support for left side

1 Support for right side

1 Stand Beam

2 Bottom Stands with wheels

2 Sliding brackets for paper take up

1 Hex Wrench (M5)®4

28 Socket flat head screws(M6*12L)

1 Installation Guide

Position the Left side vertical stand perpendicularly to part Oand put the screws into the
holes and tighten them to form a left side T-stand (Figure 2-1). Repeat the same steps with
the Right side vertical stand.

Left side vertical stand

= =5 © Bottom Stand

Figure 2-1

Installation 2-3
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Step 3

Place the stand beam upright on the T-stand and put the screws into the holes but do not

tighten them at this step. There is hexagon socket head screws fasten on the T-stand on
both side taken as locating pins.

> Stand Beam

T-stand

Figure re 2-2

Remove the cutting plotter from the carton. Position the stand under the plotter, on the
bottom of the plotter, there is one hole on each side in the position corresponding to the
locating pins, so the locating pins can be located into the holes. Then insert the screws into
the holes on the stand to lock the plotter and tighten them up as shown in Figure 2-3.

W
- \ L 7
L% ) \ ’

Screws

e . Figure 2-3

g

Installation 2-4
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Insert the roll holder support with the screws into the holes of the stand, and then tighten

them up as shown in Figure 2-4. You could decide roll holder support’s position by inserting
into different holes.

Roll holder support

V,f}j 3 screws

‘H-,;j Figure 2-4

Place two roll holders onto the roll holder support and ensure the white protrusion is wedged
in the groove. (Figure 2-5)

A Roll holder 2

Roll holder support

Roll holder 1

Figure 2-5

Installation 2-5
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Step 8

Insert the end of the roll holder without the damper into the left roll holder support and then
insert the end of the roll holder with the damper into the right roll holder support. Ensure the
white protrusion is wedged in the groove.

Installation 2-6
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Tighten the screw on the damper until it is securely attached to the right roll holder support.

Lastly, the complete picture will be shown like below. (Figure 2-6)

Figure 2-6

Installation 2-7
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2.3 USB Cable Tie and Saddle

The USB cable tie and saddle assembly for the stands with Flexible Media Support System only.

m Insert the cable tie into the upper hole of cable saddle from bottom to top.

This side up

M Place the USB cable into the cable tie and tighten the cable tie.

-.'...n‘ | 5 I

Untied way: pull out the cable tie—> pull up the pin=> release the cable tie.

Installation 2-8
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Pull out the cable tie

Pull up the pin

Release the cable tie

Installation 2-9
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2.4 Blade Installation
‘ Pin —  »
Figure 2-7 is the illustrator of the blade
holder. Insert a blade into the bottom of
the blade holder and remove the blade by

Outward ring /

pushing the pin. Make sure that your fingers
are away from the blade tip. .

Adjustment depth knob

Figure 2-7

Install blade (Figure 2-8). Push the blade to the bottom of the blade
holder (Figure 2-9).

TR

Figure 2-8 Figure 2-9

Step 3

Adjust the blade tip to suitable length by
screwing “Blade tip adjustment screw”
clockwise or count-clockwise. (Figure 2-10).

Tips:

“The proper length” means the blade’s
length is adjusted 0.lmm more than film’s
thickness. That is, if the thickness of film is
0.5mm, then blade’s length is properly

adjusted 0.6mm and it can completely cut

through the film layer yet avoid penetrating
the backing.

Figure 2-10

Installation 2-10
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Insert the blade holder into tool carriage. Please note the outward ring of the holder must put
into the grooves of carriage firmly (see Figure 2-11), fasten the case (Figure 2-12).

Figure 2-11 Figure 2-12

Use the reversing steps to remove the blade holder.

Eject the blade: Push “Blade eject pin” to eject blade when the blade needs to be
replaced.

The blade will lose its sharpness after a period of usage, the cutting quality
might be affected. By increasing the cutting force, it might do the ftrick.
However, once the blade is worn out and no longer provides a reliable cutting,
you should replace a new one. The blade is consumable and must be
replaced as often as necessary to maintain the cutting quality. The quality of
the blade deeply affects cutting quality. So be sure to use a high quality blade
to ensure good cutting results.

Tips - When to replace a new blade:

v If the blade is broken, you have to replace a new one.

v' If cutting quality is not as good as usual, you may need to replace a new one.

v If the material cannot be cut through by higher cutting force, you may need
to replace a new one.

Installation 2-11
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2.5 Media Loading

2.5.1 Loading the Sheet Media
To load the media properly, please follow the
procedures below:

Lift the 2 levers at the back side of the cutter to lift the
pinch rollers (Figure 2-13). Figure 2-13

Load your media on the platen and slide it under
the pinch rollers from either the front side or the
backside. The alignment rulers on the platen
extension will help you to adjust the media
precisely (Figure 2-14).

Figure 2-14

Step 3

Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must
be positioned above the grid drum. The stickers on the main beam show the position of the
grid drums (Figure 2-15).

Figure 2-16

Figure 2-15

Stickers

Installation 2-12
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CAUTION!!!

v" Make sure the Primary and secondary pinch rollers are set to right positions.
v' Position the Primary Pinch Rollers at the right and left sides of media.
v' Position the Secondary Pinch Roller at the center of media.

Note: Expert II serves as an illustrator here.

(O)

Correct

* Expentll

Figure 2-17

Secondary Pinch Roller Primary Pinch Roller
Incorrect

Figure 2-18

Push the lever backward to lower down the pinch rollers (Figure 2-16).

After turn on the power, the tool carriage will measure the size of the media automatically.
And the plotting cutter begins to work.

Installation 2-13
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Note:

v' Always adjust the position with the pinch rollers raised.

v' Please reposition the pinch roller by holding the center of the pinch roller and
moving it from the rear end of the machine. (Figure 2-19)

v' DO NOT move the pinch roller by holding its front rubber roller (Figure 2-20).

o —
Figure 2-19 Figure 2-20
(O) <)
Correct Incorrect

2.5.2 Loading the Roll Media

You can use the stand. Please refer to Chapter 2.2 for hardware setup, and Chapter 2.5.1
for media loading.

2.5.3 How to change the poll size without turning off the machine?

Have the machine on-line, press origin set once and the red error light will start blinking,

then pressed again and the machine will start moving to get the new size. Then open the
VLCD and under the poll size you will find the new measurements.

Installation 2-14
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2.5 Cable Connection

The cutting plotter communicates with a computer through a USB (Universal Serial Bus)
or a Serial port (RS-232C). This chapter shows you how to connect the cutting plotter to a
host computer and how to set up the computer and cutting plotter interconnection.

NOTICE: When USB connection is enabled, serial port will be disabled automatically.

2.5.1 USB Interface

Expert |l series build-in USB interface are based on the Universal Serial Bus Specifications
Revision 2.0 (Full Speed).

2.5.1.1 Connecting your GCC cutter

1. Turn on the machine.

2. Connect the USB connector to the machine and then USB driver will installed
automatically. It will take a few minutes to find the device. Please DO NOT disconnect
the USB cable until the installation has completed.

3. You can double click the USB icon on the taskbar to make sure the USB device is
detected.

"L Your device is ready to use % ¥
' Device driver software installed successfully,

2.5.1.2 Installing the driver
Use the USB One-click Installation for quick driver installation. Follow the simple steps
below for driver setup.

v" If you are using Windows 7 and above as your operating system,
make sure you log in using the “Administrator” account.

m Visit GCC website and go to “SUPPORT” page to download the user manual, driver
and software (https://www.gccworldnew.com/download.php).

GCC..

TETIS TR0 T

Installation 2-15



GCC..

Expert Il User Manual

M You may use search function or directly click the product category to choose the
model you want.

Download Area

0, BEARTCH

Or browse by machine model

Virnd Cuttar Lo Engrosar Lo Cuitoe

Diowrilood Areo

| Vinyl Cutter Vieyl Cutter

Expacert 0 & Foralt™ 2.0 AR-24
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otrzey,

Expart il Py Y Joguor v | Jacuar W (PPE)

S1CT Unzip the file and double clip the driver.exe to start installing the Driver and AAS
plug-in.

= S

s b

——
S e Vg P Y i

-

.=:J

M If you were Windows 7 and above users, please click on the red words to instruct
you how to disable Windows Update to allow success driver installation. And then click OK
to next step.

f -_

Windows 7 and abowve users please fol

step by step instructic

to dizable Windows Update to allow su
driver installation.

Tl maa

M Please make sure the cutting plotter is powered on and connected to the USB device,
and then click OK to next step.

-
e mwt e orn Fan o eley esde s el MaETES e S mry e A I..—l".l "

e st i UEH e e T L TH LR

o Lok )
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M Confirm to close all running application programs before you start installing the driver,
and then click OK.

= b e

S1CTl The installation will take a few minutes to complete and you will see a message
below and click on “OK” upon completion. Enjoy your GCC cutter!

Il Add RND-1325 Prvker deives Sucoesiully

S1CTeK: If you want to install AASII VBA on CoreIDRAW and Adobe lllusatrator, exit
CorelDRAW and Adobe lllusatrator program, and then click on“Install.”

oy GO Anl mstader V2 124
‘ Welcome to the installer for AAS | VB
ComallRayy version 11 12 13 14 151617
Afdabe Mishrator G5 G54 055 G50

I is strongly ieComimienchad thal vou €
ComDRAW and Ihustralos program be
cortinuing

M Check Install Message to confirm CorelDRAW and Al version and then click OK.

e = r
e — )
Ik gL |13 DO i g ms iy
]

Installation 2-18



GCC.. Expert Il User Manual

Note:
(1) If the driver is being installed for a second time, the user will be prompted as to
whether a second copy of the driver installation is required.

Tee K135 drvei st
;_I., Tl piens ol I el iy S i !

W, e

s AKE-1 00T L Pricker deveer SuccensSully

o |

(3) For users who have upgraded Adobe lllustrator or CorelDRAW, please go to the
AAS Installer page in the Printer Properties window and click “Install” to access
the latest version of GCC AAS Plug-in.

GO0 AAS frestalion

Fress tha *Instal” button fo begn the
installabion process

insguk
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2.5.1.3 Driver Un-installation
You have to remove previous version driver installed on your PC system completely

before you can install the latest version successfully. Please refer to below steps.

M Go to Control Pane\Hardware and Sound\Devices and Printers window. Right
click the printer and select “Remove device.”

AL ki Add @ g wm wbed o Ay = bl o bl i R T STl mpee mag e

e

M Frinies aned et 11

'l." ’ll' J ||'II ._,-'I-_:d": ‘l'r

.-."l ok il 0 prTEIY
Le g Tt ar dafick pemiw
Froiomg prefare s

Froiw prepEsm

il prod geEse

RN V- L BT Crativie
Fil§

Lyl thicho il

Are ol sure you want o remcve Ehis deviee?

RXE-112%
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MAﬂer removing the unit, click on any printer on the page and select “Print server
properties.” (For Win 7 and above)
Or right click on blank space and then select “Print server properties.” (For
Windows XP)

& (onbrPyeil i Hedeww i Sesed & Do ord Boriem

L |
e e iy e T ama § prvTTy Hrngr prived preewer l'r-'ll'rlrm-.l - ‘

: Diviem [

& Provilird and Faies 101 I

o EN AN Adche FIV Eaizp FIN Fm Doambna CIDO0H H'umnll?i
Ko iR Prrin Taew gmvard Wnkin
3~ N
e
BAIT N L1 )] II'II l:ﬂl:l'rlr

S1CT ] Select “Driver” page

Heo
i i?
it

T
1

Coppte o new farmm

form dripien (mesuremerisl

nEn = Meng Erqjlah

P yiom Erimter pres FEnG
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M Select the model and click on “Remove”.

— e - I BT

o Piint bervr Pri

TR
P

[ ] e T gl

, PIARERT -1 EEMT

| netatled prm diroe
Hasa
#dcbr POF Comenin
Baulbsop PDF Fivnie
Beilzg FDF Frnbes
Graphie: CRBIHD
HE Calor Lanmdei 78] 5.
el
WECrooll s=hamsd Fod.
Whcropati ZPE Documen..
WRITOH WC-1 000 Trpa 1 -
EAE-10LE Tirpee 3 + L Mzde
oaiam & Tiged U hiede
e 1 Ty 1 - Uper blsde

:

Trper

Tipal -
Tt 3

Treel-
Tope 1 -
Typm il -1
Tt 3 -
Tt 1 -
T -

ERERERBBREF

L

| gk :_hl-mm'l. | | Prppere
S Changge Dervws Satiingn |

D jais wiisk 1 pirmas Iha divanly) only, of remsve
e eivwrs) and drinver packigeis] Trom yeur sywlemT

[ Eemnove diver and dnves peckage.

=

M Click Yes and then click “Delete” and “OK,” and the driver installed on PC is
completely removed.

Deleting this printer driver package will
remove it from the system. Are you sure

you wani to delete BXI1-1325 17
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) e

[t [k B Pl Pt Cple1ES Dirwt Py Gest
== == e ———

| The Fobosang divetfi] wil b deedid | Drewwd SO0 1525 2 ol v

BCETT- L0 )

2.5.2 RS-232 Interface
B Connecting to the RS-232 (Serial) Port

1. For IBM PC, PS/2 users or compatibles, connect the RS-232C cable to the serial
connector of the assigned serial port (COM1 or COM2) of your host computer.

2. Set up the communication parameters (Baud Rate and Data Bits/Parity) to match the
setting of software package, refer to chapter 3 — “Misc” key description.

Caution!! Please turn off the plotter before plugging the RS-232C

2.5.3 Data Transmitting
There are two options to transmit the data from the computer to the cutting plotter:

Option 1: With proper interface settings, the data can be transmitted from your application
software package to the cutting plotters directly.

Option 2: Most cutting software packages are able to emulate HP-GL or HP-GL/2
commands. As long as the file is HP-GL or HP-GL/2 format, the cutting plotter
can output the data precisely.

Installation 2-23
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2.5.4 Printer Sever Shared Setting
In “A-PC”, set the printer driver as a shared printer, then use B-PC to connect A-PC'’s printer
driver via Intranet.

A-PC B-PC
Intranet

T oL

USB or COM

M Set A-PC’s printer driver as a shared printer (Right-click on printer icon, choose
“Printer properties”. Click “Sharing” tab then check “Share this printer.”)

i
Shawyg Pw

|G | Acvarcond, | Cokor Marmgurrars | Secumy | Optar

Wina it ifiin tha poabei silh olled s on your nfsork. |

S peeter will not be svalsbis when the compuates & sheepig or
cff

o

[/
< See what's printing

: Set as default printer ; " e ] 2
Printing preferences
o fender prrd jabs an clent compul e
I Printer properties I
Lk i this direchosy
Create shortcut
Oirrymry
Troubleshoot IT e piabilest i dhared wilh ubsin iunming dfecent wemions of
L . Warahowwel, poad ety wani o watall addi€seal @rrer, so Shat Bae
= Remove device sy i nok buree B0 Bl Bhe print driver sher thary cormect o 8
Jagua shaied itk
Properties Fvrm——rs
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GCC..
M Click “Advanced” tab, then choose “Print directly to the printer” option.

Bengal-60 Properties

| General I Sharing '.En;th.ﬂdﬂﬂﬁd Color Management I Security I Opti

@ Always available

7 Available from 12:00 AM = To 12:00 AM
Priority:
Driver: o | | New

) Spool print documents so program finishes printing faster

Start printing aftqr last page is spocled

(@ Start printing immediately

@ Print directly to the printer:

[ THold mismatched documents

S1CT] Send a job from A-PC to the machine to check if A-PC is connected to the machine.

% CorlDRAW 11
d CorelDELW X4 () =

Expert 24 LE

Try to send a job
to check if the
port is working.
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M Activate A-PC’s Printer Driver from B-PC’s Network.

Aﬂiﬂ Metwork =

ADMIN-ANITAY! E{ﬁ Bengal-6

e
(8 ADMIN-ELAIN P
% ADMIN-HR > Eé-éﬁ ool
- |8 ADMIN-JULIA : A
oL
-l
.

ALBERTTHIMK
CBAD20003
CBAD50023
CBADS001S

M Right-click on the printer icon, and select “Connect” to A-PC’s printer.

iﬁr Open I
. | Connect... ||

Create shortcut

2.6 Software Installation

2.6.1 GreatCut Installation

m Visit GreatCut online registration page http://gccvoucher.eurosystems.lu/, enter your
voucher code provided when purchasing GreatCut and click “Go on!”

G':.E.E't Cut : _ _ i

Ereablul Toscher Coa

-"‘L- Surs Cubs & Lok
pi -

m i T A

sreal Computer Corp Boftwere Youcher Code m G{Et GJT

—
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| Great Computer Corp Software Voucher Code

§ Finaas pnini Fo ouche Sde comoneie 'y End @

¥ wibariee oo |00 R A O ]

a0 e =
1
N Eans of proeswm B gueEREes

| | Hume ot e Comoant Sa

M Click “Request” to go to registration page.

| Ghent Computer Coip. Software Yoochs: Code
I'.ll-m-'..l!.l:: T

o Aercde & erfass anebe for o UH ioeee. O G e

| i erimn e reiwtin s Prow of charge foriis S oo dewrloid SraalCle 2 pasks i B BRrayyy) oufion

| LECRARE TTH T Py Pyl -

™~

il Fiesl TS BPL Tl AT T TR

crpbw'y ua i viwds un B rachal
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GCC.. GreatCut
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GCC.. GeeetCut

S1CT Fill in the required information and click “Request license code.”

I Soffware Download GreatCut 3

Great Gt
—
Sohware Aegistation
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M The registration is completed; you should receive two emails, one is registration
confirmation with activation link and another is your license data with .ecf file.

Fegistration Successtul
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M Check your email to see if you receive the activation link and click the link that will
direct you the link for GreatCut download.

Fug el Mg 2 e
il whera rhrad pr r=n b
Bz

=a FearL 1 - Actrawenn Lins

Do Canoms

hank vou. that vou decided for GreatCut 3
Plesie elick the fallevidag aetivation link o eanes le in vour web brevicuer

mwmuhmmuu:mwﬂm&:UﬂiﬂElﬁﬂbﬂlﬂﬂﬂEMm\
Affter didking the nk, vou mesedisteby will ger download Buls and license dara for GresCor 5
B woag Bave queitloo, Voo cif prach oof suppest over bech nipipen @ joc soim W

Bt regarda
Grent Computer Cop

M Visit GCC website and go to “SUPPORT” page to download the user manual, driver

and software (https://www.gccworldnew.com/download.php).

Download Area
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Or browse by machine model

Virnd Cuttar Lo Engrosar Lo Cuitoe

Diowrilood Areo

L Vi n’yl Cutter Wiryl Cuttar -

Expacert 0 & Foralt™ 2.0 AR-24
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£
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LI Bifw Dlrwirlcind
Geroatiout 4 hor Windows (V17 0000 7868) T Dyttt
Sure Cuts A Lot § for Windows Bd b [vE_044600 ) LT [Ep
Surg Cuts A Lot 5 for Windows 32 bt (vl 44600y % ThiE Lirrmd i
Sure Cuts & Lot 5 for kad (uS_04400c) [ T——

S

S1CIJ Select a destination folder.

S1CTeK: Select Typical and click Next.
Note: You may select custom setup to install additional drivers.
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M Select the folder and click Next.
Default program folder in the start menu is GCC\GreatCut 4.

m Click Finish to complete installation.

Pl ] ' | et
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M Before you launch GreatCut, open the .ecf attached to the license data email to
install your license data to GreatCut so that you don’t need to fill in your
information again.

Fag BCo-A L T - borm s oot o i 55

S | wimnn Uy LnoL e
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GCCGreot G
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1 License dara {9 GraarCug 3

The follvwing license code will be aciivaied by copning or saving the st
155

For & porssibly pacessary muannat impar, heve the license daks (meen ) again

Coopany  Name GLT

ehadall pllems whiem B gor oo o
Cnds G 16aP

Homber of Lirenses |

Seral Mo AP JEAT

.~ - B
Live Update: — ﬂ

License installed successfully.

S1CTJ K] If the license do not install successfully, you will need to fill in your license data
manually. You can find the details of your license data from the email.

N
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m GreatCut is ready to use now.

Ertanlar |

2.6.2 Sure Cuts A Lot Installation (Optional Item)

LR | FLill ==
BT T ]
i
1 ] -
IR T

Expert Il User Manual

Ther (idlorwung Lempon coda =il b aciivniied by repreg o mering Ther sitacked Elc iv (e tompirio e sty b = doulic Gk Thas (kb
st vt is dear Faly sameane sad Caewiar 1 s reedly 15 ses

Jimgula in plain 6l

Camggmip P Y
|_-'-'llu sdee ot A cem e
sl o 14p
Nomhg =f Limam 1
Brrinl Ma GLIAP- LT

2.6.2.1 Auto Installation

M Visit GCC website and go to “SUPPORT” page to download the software
(https://www.gccworldnew.com/download.php). The software is compatible with

Windows 7 and above and Macintosh OSX 10.6 and above.

GCC...

innowodnn

Download Area
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Or browse by machine model
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M Download “Sure Cuts A Lot” to start the installation.
S1CTJ] Press Next to continue.
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M Use the default folder (suggested) or select a folder you want to install the Sure Cuts

A Lot and press “Next.”

14 Sk - fap Cos & L

Sefert Dertinalion Lisiatiss

e whousd Sorw Tl A Lat 4 be rocbelied |

§ Setigy wll il Soee Jinly & Lo 4 nng B oo Sokoes
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= ———— .

I

~

M Tick “Create a desktop icon” if you want to create a shortcut on your desktop, and

tick “Associated scut4 extension” to associate the scut4 extension file with Sure

Cuts A Lot software. Then press “Next” to start the installation.
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Select Addibional Txsks
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S1CTJl Don’t tick “Install USB Driver” and tick “Launch Sure Cuts A Lot,” and then press

“Finish” to compete installation.
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| P Stage - Suen ity & e d |

Completimg the Sure Cuts
Setup Wizard
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1 k:] Run Sure Cuts A Lot.
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M Press “Activate...”to activate Sure Cuts A Lot. Please make sure it is connected to
the internet.

Sure Cusgs & Lot d Demo bode
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m Put your name in the Name column and enter the 25-letter software key to the
Serial column and press “OK” to complete the activation.
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ta Tyorw oty . Lot §
Piease e o Muse aned Zenal
Flomon srosiey worey Horwr e Sl / i . - e
— AT
Eaxwr h—

o Thank yoa for actieating the mu/

Hoysy niad 20 mive the saffwan e e oz
Cleartinits irndar tha FHelp =shu Bequicm ar

M Launch Sure Cuts A Lot, select “My Cutter” under “Cutter” and select “Manage

Cutters.”

M Select Company/ Brand as “GCC” and the model you want to output, and then click
the “Add to list” button and “Done.”

1 13

-+ WAsnage My Cutlers B ——

Cutters you ourrenty hove added are isted below. To add anc

10 Add argiiher Grand Modsl,

CLSier
| GoCi-craf
GOC

Brid o Cutie

Company it

| = =

Note
v' If you use a trial version to

output graphics, meaning
you do not enter the
software key to activate
the Sure Cuts A Lot
mentioned above, there
will be two extra lines cut
through the design,
therefore, make sure the
Sure Cuts A Lot software
is activated before
implementing cutting jobs.
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2.6.2.2 Manually Activate Software

If the computer connected to cutter doesn’t have internet connection to accomplish above
software activation process, you can use “Activate manually” function alternatively to enter
the “Activation Code” to start the usage of Sure Cuts A Lot. Meanwhile, you need to find
another computer that has internet access to obtain the “Activation Code” in advance
following below instructions.

m Check the "Activate manually" checkbox and you should see the Site Code and
Activation Code fields appear. The Site Code field will be pre-filled in and cannot be
changed.

Ativats Suis Cubs & Lo 4

Plears snber s Hame, Serel sadl Actrenion Cods

Harme '
Seral |G| 31 45600 ] 04 | DR AT 2
S Tl

4 Acavals maeally Cangel

1E 3o sre urab® fo s teede, check te Aotk menesdy opbor, end
¥

By s ¢ vaPed e s ivdhit dieivi i sdiisin iy L Bosien coela

M Visit http://www.craftedge.com/activation/surecutsalot via an internet connected
computer. Enter your name, serial (software key shows on the voucher code card)

and site code.

GeeolGyt S
r.-u-::wl'"r""-"l' "-';""

Sure Cuts & Lod
B T ey e

e
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S1CTl Click on the "Generate Activation Code" button, and your activation code will be
shown in the Activation Code field.

Aillwale “Higre s & sl
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M Copy and paste the activation code back into the activation dialog box of Sure Cuts A
Lot program and hit ok.

2.6.2.3 Re-install Sure Cuts A Lot Software

If you change a new computer, you may need to deactivate your Sure Cuts A Lot software
and re-install it on your new device.

Go to “Deactivate...” under Help and press Yes to confirm, then follow the installation
procedure and use the same code to activate it on another computer.
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P

.~ Deactivate

Are you sure you want to deactivate the software?

Deactivating will allow you to re-install on a different cc
(Requires an Internet connection)

™~
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Chapter 3 Operation

3.1 The Control Panel

311 The Outline of control panel

= z 7
P‘E-"u-'EH DNDFF LINE F'.ALISE HEF'EAT DAT-ﬁ. CLEAR CUT TEST ORIGIN ._+ET
v,

.
Figure 3-1

Key Function

POWER LED To indicate the power status ( light up: power on; light off: power off )

ERROR LED To indicate the error status ( light up: error; light off. normal )

To switch modes or stop cutting job( light up: on-line; light off: off-line )
ON/OFF LINE While in on-line mode: only ON/OFF LINE and PAUSE keys activated

While in off-line mode: the settings in VLCD can be adjusted.

PAUSE To temporarily halt cutting process or to continue

REPEAT To repeat last job.

DATA CLEAR To clear up buffer memory.

CUT TEST To perform cutting tests on different media.
ORIGIN SET To reset origin at a new position.
4 Arrow Keys To move carriage position, select function, or change setting.

3.1.2 Reset Origin

Note:
v Make sure the machine is in off-line mode to enable this function.

Operation 3-1
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M Move the carriage to a new position.

M Press the ORIGIN SET button to reset origin.
3.1.3 Cut Test

Note:

v' Make sure the machine is in off-line mode to enable this function.

v It's recommended to keep performing this function until the cutting
quality meets your demand before executing the cutting job.

MAfter sizing, press the ON/OFF LINE button to set as off-line mode.
M Move the carriage to a preferred position.
M Press CUT TEST button to perform.

3.1.4 Repeat

Note:
v Make sure the machine is in off-line mode to enable this function.

M Press the ON/OFF LINE button to set as off-line mode.

MPreSS the REPEAT button to perform re-plot function starting at the position where
the carriage locates. It is also available to move carriage to a preferred position,
re-set origin, and then perform this function.

3.1.5 Repeat AAS Job
This feature allows users to repeat AAS jobs automatically without having to operate on the
computer side.

M When the first AAS job finishes, press “Repeat” on the control panel to activate this
function.

Note:

v" Please be noted that this feature is mainly applied to the Single paper
mode; ensure a new piece of material is loaded and the origin
repositioned to the first registration mark before “Repeat’ is pressed.
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3.2VLCD
“VLCD” is a computer program to help modify parameters of cutting functions.

3.21 Installation
m Download the VLCD.exe file from download area on GCC website onto your local
drive to finish installation (Download Area — Vinyl Cutter — Expert Il — Software,

https: //www.gccworld.com/download.php?act=view&id=21).

¥ Launch VLCD by double-click on the icon.

Note:
v' Make sure the machine is in on-line mode to enable this program.
v' There is media in the machine.

M Choose the right port connected to your computer (Figure 3-2).
If you are using the USB cable, choose the model name from the pull down menu.
If you are using a Serial cable, choose either COM1 or COM2. Make sure no other
devices are occupying the port that you are going to use.

MPress the Connect button to connect your computer and the cutter. If the
connection succeeds, the model info, firmware version, and adjustable parameter
columns will be showing (Figure 3-3).

@ VICD3 VIo40
[Expert 11 24 LX @ | Model-Expast Il 2
= ‘ Version: 1.04-14
Setting | Adjust |
Paper Length (X} @ mum Paper Length (] 240837 mim
Paper Wikth [¥) 0 i Paper Width (¥) 141.625 mim
Blade Force | Blade Holdar Binde Force 5 a Blads Holder FI
i] _] b
Blade Offses Blade Offset [0 = | mm
Madla T]IM L Media Type | ol |
Media Weight Media Weight  [Light =]
Auto Unroll -] Auto Unroll  [Disable ~|
Vector Quality ; Vector Quality iF{I'IEI 'I
Vector Smooth - Vector Smooth  [Disable =)
Figure 3-2 Figure 3-3
Operation 3-3
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3.2.2 Functions of VLCD

Below are the functions adjustable in VLCD for Expert Il.
m  Poll Size

m Blade Force

m Blade Holder

m  Media Weight

m Blade Offset

m  AAS Offset
s Auto Unroll
m Update

To reveal the X/Y values.

¥ VLCD3 V2.04-02

i i Expert 11 24 LX - Model:Expert 1l 2
In the case, the maximum plotting length | N J Version:3.04.14
is 256000mm, and the distance between
the farthest two pinch rollers is 158.975
mm (Figure 3-4).

Setting | Adjust |

Paper Length (X} 25000 mm
Paper Width (Y} 158.975 mm

Vector Quality Fine -
Vector Smooth  |Disable ~

Blade Force 35 g Blade Holder |ﬁ
] o 0
Blade Offset mmm
Media Type Rell
Media Weight  |Light  ~|
Auto Unroll W
Fine  ~|
Disable - |

Figure 3-4

m |Blade Force
To adjust the blade force between 0 and 350 (Default = 35).

Note: when plotting with a pen, adjust the Force to the lowest setting to avoid faint lines as
well as to extend the life of a pen.
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Blade Holder

To choose the blade holder- Plastic (Default) or Metal.

Media Weight

To choose different weights of media in two options: Heavy, and Light (Default).

Blade Offset

To adjust the blade offset to ensure cutting quality in 8 options: 0.000, 0.175, 0.250
(Default), 0.275, 0.300, 0.500, 0.750, and 1.000.

IAAS Offset

To set or modify AAS offset value.

You can refer to “5.3 Printer Test” for more details.

b VLCD3 V2.04-02

[Expert Il 24 LX

E

Setting ﬂdil.lst l

STEP1
Draw a square for testing

Length (X) 500.0 mm

Model:Expert Il 2
Version:3.04-14

Scaling Test

Width (Y) 500.0 mm

STEP2

Length (X) |500.0

Width (Y)

AASI Offset FU

AR W oMNIT _a i

/Auto Unroll

0.0 T Calibga

Measure and enter the actual output

To switch options for sheet media and roll media (Auto Unroll On: Default).

To apply the changed setting onto the cutter by presses the Update button.

Operation
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3.2.3 Restore factory default settings
VLCD allows you to turn all parameters to factory-default settings.

m Enter the USB-port switching mode by pressing “Pause”(2) after “On/Off line’(1) and
then press “Origin Set” (3).

: S

O P i Hl: nulﬂ.u-l- cu.ru mz-.l-f

&
s m mmm L-Nnd cﬂun

m You have now entered the Data clear and restoring default settings mode; press “Data
clear” (6) and then “Origin Set” (7) to confirm.

m M‘L‘LIM I--P#Fl tﬂ'ﬁlil

m The default settings restoring process has been completed. All buttons will be ineffective
before the cutter is rebooted.
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M Restart your cutting plotter now.
3.3 File Uploader

3.31 Installation

v “File Uploader” is a tool to help loading files for direct output.

v The program ONLY supports HPGL format-files generated via GCC Cutter driver.

v Download the GCC File Uploader.exe file from GCC website onto your local
drive to finish installation (Download Area — Vinyl Cutter — Expert Il — Software,

https: //www.gccworld.com/download.php?act=view&id=21)

v Launch GCC File Uploader by double-click on the icon (Figure 3-5).

.~ GCC File Uploader

Select a Download File I e Com Part Setting
|FiIeName Browse | Fepeat Delay —
13_ - Baud Fiate ; (EEHT -
Select a Part . t*_l:l t R m
|I:EII'-11 L] Fart zetup | St Paity |Nnne =
1 =1 )
Frocess 0 L =1 Stop Bits |1 -
LhEbg ."'l1 Flow Control :(Hardware  »
n = 1]
. Start | Cancel Exit |
0k | Cancel |
Figure 3-5 Figure 3-6

3.3.2 Functions of File Uploader

m |Port setup

v" This function will be activated while choosing COM port for data transmission.
v" Press the Port setup button to pop up the setup window for parameter change (Figure

3-6).

.

v Activate this function by click on the Repeat’s checkbox.
v" Repeat Delay — the pause time between jobs; Unit second.

v" Repeat Counts — the number of repeat jobs.

Operation
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3.4 Data Transmission

There are two options to transmit the data from the computer to the cutting plotter:
Option 1: With proper interface settings, the data can be transmitted from your application
software package to the cutting plotters directly.

Option 2: Most cutting software packages are able to emulate HPGL or HPGL/2 commands,
therefore. As long as the file is HPGL or HPGL/2 format, the cutting plotter can
output the data precisely.

3.5 Expert Il Print Driver Setting
3.5.1 Expert Il Print Driver setting>Option Page

File Function:

The file function section allows users to set the parameters of Speed, Force, Offset and Quality
for later use. This section is useful when performing repeated jobs on a variety of objects,
allowing you to save your frequently used cutter parameters and load them in the future.

» Custom Media: This section lists the files for the parameter settings that you have recently
created and worked. You can save more than 50 files to simplify your cutting job.

» Default This section contains the reference settings that are applicable with the verified
materials to achieve the best cutting results. Please note that the setting value might need to
be adjusted according to different suppliers of materials.

* SAVE: This function will save current print driver parameter settings to a file under the
specified location on your computer. (Saved parameter setting files will be tagged with the
Expert Il series extension)

* LOAD: This function allows you to load previously saved print driver parameters.

* ORIGINAL: This function will load the print driver’'s original factory parameter settings.

* SAVE TO DEFAULT: This function allows you to save your current print driver parameters as
the default startup settings.

Operation 3-8



GCC.. Expert Il User Manual

« DELETE: This function will delete the file you select from the Custom Media section, whereas
the settings in Default section cannot be deleted. Please note the delete function only
removes the list shown in Custom Media section, it does not remove the file from your hard
drive, if you wish to completely remove the file from your hard disk, you will have to manually
delete the file from your operating system.

Die Cut

The Die Cut function must be activated with the Kiss Cut function to avoid the falling of
cut-through materials and material jam beneath the carriage. Die Cut helps you to cut through
the backing of the material while Kiss Cut cuts through only the top layer but not the backing.
This will leave only tiny bits of the backing attached to the top layer, creating complete individual
patterns with backing sheets (see figure 3-7 and 3-8).

Bla

Top layer Vinyl

Backing sheet

Die Cut

Kiss Cut

Figure 3-8
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To activate the Die Cut function, go to “Option”, tick “Die Cut’, and enter the amount you wish
for the “Length” and “Force” of both Die Cut and Kiss Cut, then click “OK” (see figure 3-9).
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*Note:

The length setting for the
cutting line of Die Cut is in the
range of 0-2000mm whereas

/ that of Kiss Cut is 0-100mm.

Figure 3.9

When the job is completed and you untick the Die Cut function, you will be able to adjust the
pen speed, pen force, and offset in the section on the top following normal operating

procedures (see figure 3-10).
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Note:

1. The extension of the blade has to be set to
cut through both the top layer and the backing
in the very beginning. You then adjust the tool
force for the best cutting performance.

2. Once the Die Cut function is activated, it
will perform on all the line segments on the
object.
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Figure 3-10

3.6 Reference Parameter Setting for Different Materials
The following reference parameter is used on GCC verified materials shown in the table.

Personalized/ Wall

Material I Vehicle stickers Window decoration Window tint
Blade red red red red / yellow
Blade tip length (mm) 0.28 0.27 0.25 0.09
Force (g) 105 85 95 70
Speed (cm/sec) 72 60 65 72
Offset (mm) 0.25 0.25 0.25 0.25

Recommend model

RX, Jaguar, Puma,

RX, Jaguar, Puma,

RX, Jaguar, Puma,

RX, Jaguar, Puma,

EX, AR EX AR EX, AR EX AR
Material Stencil Reflective film Flock Cardboard
Blade red / green green green green
Blade tip length (mm) 0.3 0.5 0.3 0.3
Force (g) 180 380 135 165
Speed (cm/sec) 15 3 30 30
Offset (mm) 0.25/0.5 0.5 0.5 0.5

Recommend model

RX, Jaguar, Puma,

RX, Jaguar, Puma,

RX, Jaguar, Puma,

RX, Jaguar, Puma,

EX, AR EX EX, AR EX, AR
Material Magnets Protective tint Rhinestone Sandblast mask
Blade green green green blue
Blade tip length (mm) 0.8 0.3 0.8 0.27
Force (g) 580 320 190 85
Speed (cm/sec) 3 3 15 60
Offset (mm) 0.5 0.5 0.5 0.25
Recommend model RX, Jaguar RX, Jaguar, Puma, RX, Jaguar, Puma RX, Jaguar, Puma,

EX

EX, AR

Material Small text (vinyl)
Blade black
Blade tip length (mm) 0.27

thick: 150
Force (g) thin: 90
Speed (cm/sec) 9
Offset (mm) 0.175

Recommend model

RX, Jaguar, Puma

Operation
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Chapter 4 Basic Maintenance

This chapter explains the basic maintenance (i.e. cleaning the cutting plotter) required
for the cutting plotter. Except Il for the steps mentioned below, all the other
maintenances must be performed by a qualified service technician.

4.1 Cleaning the cutting plotter

In order to keep the cutting plotter under good conditions and have the best performance, you need to
clean the machine properly and regularly.

Precaution in Cleaning
< Unplug the cutting plotter before cleaning.
< Never use solvents, abrasive cleaners or strong detergents for
cleaning. They may damage the surface of the cutting plotter and
the moving parts.

Recommended Methods

« Gently wipe the cutting plotter surface with a lint-free cloth. If necessary, clean it with a water-rinsed
or an alcohol-rinsed cloth. Wipe the cutting plotter to remove any residues on the cutting plotter.
Finally absorb water with a soft, lint-free cloth.

% Wipe all the dust and dirt from the tool carriage rail.

+ Use a vacuum cleaner to clean any accumulated dirt and media residue beneath the pinch roller
housing.

+ Clean the platen, paper sensors and the pinch rollers with a water-rinsed cloth or alcohol-rinsed
cloth. Finally absorb water with a soft, lint-free cloth.

% Use the same method mentioned above to clean dust and dirt from the stand.
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4.2 Cleaning the Grid Drum

< Turn off the cutting plotter, and move the tool carriage away from the area needed to be cleaned.
% Raise the pinch rollers and move them away from the grid drum for cleaning.

% Use a bristle (a toothbrush is also acceptable) to remove dust from the drum surface. It needs to
rotate the drum manually to clean the drum completely (Figure 4-1).

Figure 4-1

4.3 Cleaning the Pinch Rollers

If the pinch rollers need a thorough cleaning, use a lint-free cloth or cotton swab to wipe away the
accumulated dust from the rubber portion of the pinch rollers. To prevent the pinch rollers from rotating
while cleaning, use your fingers to hold the pinch rollers in place.

Use a lint-free cloth or cotton swab rinsed with alcohol to remove the embedded or persistent dust.
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Chapter 5 Automatic-Aligning System

AAS Il (Automatic-Aligning System Il) is only available for Expert [l LX models. For Expert Il 24
or 52 users, you can skip this chapter.

Please note that this chapter is only an instruction to AASII; for step-by-step instructions, please

refer to the following chapters: 07_A-4 CorelDraw Plug-In, 07_A-5 lllustrator Plug-In, 07_A-6

GreatCut Plug-In.

5.1 Introduction

The Expert Il cutting plotters feature a standard Automatic-Aligning System (AAS II) to
guarantee precise contour cutting quality by detecting the registration marks printed around the
graphic.

Notice
B Avoid any kind of light source horizontally illuminating the AAS module.

- PROHIBITED - ACCEPTABLE

B DO NOT take off the cover of AAS module while in operation.

- PROHIBITED
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52 AAS Contour Cutting System

The AAS system has one calibration procedures to ensure maximum accuracy of AAS
operation. To operate the AAS you need to learn about the method of media feeding firstly.
(Refer to 2.4 Media Loading.)

5.2.1 Notice for Registration Marks
The first registration mark is designed to be different in order to identify the origin for AAS
auto-detection. The following precaution must be aware for registration marks to be read
automatically.

Type of media

Registration mark pattern

Reading range required for detection the registration marks
Position for registration marks and medium

The registration marks have to be:

Created by cutting software like GreatCut or GCC CoreIDRAW plug-in

In black color (printing quality of registration marks is essential; incorrect,
misaligned colors, blurry or smeared printout might leading to inaccurate cutting
result)

Length: The length of marks

- Range: 5mm~50mm

- Optimized Setting: 25mm

Thickness: The line thickness of marks

- Range: Tmm~2mm

- Optimized Setting: Tmm

Margin: The distance between marks and images

- Range: Omm~50mm

- Optimized Setting: 5mm

The cutter can not detect the marks while:

Cutter carriage is not located near the outside area of first mark before
detecting (See the picture in page 5-7 for auto-detecting area of first mark.)
Medium thickness is more than 0.8mm

Transparent medium is used

Non-monochrome drawing. The marks can’t be read if is printed on colored
medium

Dirty or creased medium surface
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5.2.2 AAS ll on Expert i

There are three types of AAS Il mark patterns: 4-Point Positioning, Segmental Positioning, and
Multiple Copies. Note that before print out your designs by inkjet printers, the registration marks
have to be created on your graphic designs by cutting software like SignPal, GreatCut or GCC
CorelDraw plug-in. Hand-made marks or drawings won’t be reorganized by GCC cutting
plotters. For more details about registration mark setting in cutting software, please refer to
‘Appendix A-4 : CorelDraw Plug-In Instruction’, ‘Appendix A-5 : lllustrator Plug-In’, Appendix
A-6 GreatCut Plug-In.

1. 4-Point Positioning
This is the basic mark pattern that AAS Il will auto detect four registration marks and contour
cut images inside those marks.
m  Command: Esc.D1;(XDist);(YDist):
m Layout: 4 registration marks at the 4 corners around the design

I
I

2. Segmental Positioning
In addition to 4 original points, the intermediate registration marks are added on both X axis
and Y axis to help contour cut accurately, especially for cutting large images.
n Command: Esc.D2;(XDist);(YDist);(XStep);(YStep):
n Layout:
In-between distance on X: 200~600mm, default 300mm
In-between distance on Y: 200-600mm, default 300mm

3. Multiple Copies
The function is used to duplicate images to let you cut quantities of images at a time.The
AAS Il sensor will automatically scan registration marks for each individual image to ensure
the contour cutting precision.
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n Command: Esc.D3;(XCopies);(YCopies);(Space):
n Layout:

5.3 Printer Test

Before performing AAS contour cutting, it's recommended to print out a test file to make
sure the AAS Il cutting accuracy. Please visit GCC website and go to Download Area to
download the test files.

https:// www.gccworld.com/download.php?act=view&id=20

m Ao ——
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There are two testing files for AASII:
1. AAS II_X_Y_Offset_Caberation_A4 .eps (A4 size)
2. AASII_X_Y_Offset_Caberation_600_600 .eps (Default setting, it is recommended
for testing)
B Print out the testing graphic. ( Please use high precision printer)
B Load the graphic to Expert Il and sent the file to test the cutting job
B If there are any adjustments to be made, you can change the offset value by
following the steps:
m Measure the offset values from the printed line and the actual cutting line.
m Enter the AAS Offset under MISC function for the values you just measured,
then press Enter
m Test the cutting again
m  AAS |l offset X and Y value is defined as following:
Horizontal line is defined as X and vertical is defined as Y (when facing the
cutting plotter)
m When the actual cutting line and the printed line need to be changed towards
the direction of origin mark, then simply add the negative value of the offset.
If the direction is from the opposite of the ¢~~~ ~rk, then enter positive
values for the offset (see the following figu s method applies to both
XandY axes.
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Note:
B Before adjusting the AAS Il settings, please proceed scaling for width and length.
B The blade offset value isn’t set for this test graphic, please set it according to the
blade you use.
B If you have any question, please contact us or your local distributor for assistance.

5.4 Registration Mark Offset Range

Please correctly load your media (refer to the alignment ruler on the platen) to make sure the
registration marks are successfully detected. Deviation exceeds the range below will lead to
detection failure.

5.5 Contour Cutting

For accurate contour cutting with AAS function, please proceed the following steps:

m Creating Graphics
m Create the graphic that you want to print and cut in your software.

TIPS1: Leave some space between the graphic and contour line.
TIPS2: Create the contour in a separate layer and assign a different color for it.
m Add registration marks around the graphic.
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Note:
The Multiple Copies function is also available. It automatically copy the graphic and
registration marks.

M Placing the Registration Marks
m The AAS Layout Instruction:

- |

* Auto-detection function on the 15t mark covers the grey area
m  Suggested 30mm margin on both left and right sides of media sheet.
m  Suggested 20~30mm margin on top of media sheet, and at least 50mm margin on
the bottom edge to prevent sheets dropping or any error occurred while media sizing.
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M Print the Graphics
m Print the graphic and the marks with your printer

(Scaling = 100%). E’i B

m When printing on a roll media, make sure the orientation as following:

M Load the printout onto cutter
m The Origin Mark is different from the rest registration marks. Please make sure the

media is fed with correct direction.

M Cut the Contour

m Send out the command from software to perform the contour cutting job.

5.6 Tips for AAS

For getting better results of contour cutting, there are some tips below for your reference.

m  Keep light sources simple and avoid illuminating from the sides of cutter.

m  Before operating AAS, change the maximum paper size in Expert |l driver
property.
m Find the Expert Il model in the “Printer & Fax” folder of your PC.
M Open the Properties window and select the “Paper” tab.
Change the maximum Paper Size of X to 1200mm.
Adjust the cutting speed to between 200~400mm/sec.
Avoid the registration marks locating on the tracks of pinch rollers.
Make sure the edge of the media is not bent up when detecting registration marks.
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Chapter 6 Trouble Shooting

This chapter helps you to correct some common problems you may come across. Prior to
getting into the details of this chapter, please be sure that your application environment is
compatible with the cutting plotter.

Note:

Before contacting your local dealer, please make sure that the problems are coming from your
cutting plotter, not from the communication between the computer and cutting plotter or from a
malfunction in your computer or software.

Why doesn’t the cutting plotter operate?

6.1 What if Expert Il cannot operate?

If your cutting plotter doesn’t plot, please check the following items first

Is the power cord plugged in properly?
Is the power cord connected to the power connector properly?
Is the power switch turned on properly?

Solutions: If the POWER LED lights on, the cutting plotter should be in a normal condition.

Turn off the cutting plotter and turn it on again to see if the problem still exists.

If the POWER LED doesn’t light, please call your local dealer to resolve this
problem.

6.2 Light Indicators

Some of the operating problems can be identified by the lights on the control panel.
When your cutting plotter stops operating or the lights are on or flashing unexpectedly, see the
following descriptions of the panel light patterns and the actions you should take.

Trouble Shooting 6-1




GCC.. Expert Il User Manual

6.2.1 Warning Indicators

When the ERROR LED flashes (as shown below), take the necessary actions according to
the following instructions. When the problems are solved, the ERROR LED will turn off
automatically. Pressing the ON/OFF LINE button can also turn off the ERROR LED.

ON/OFF DATA | CUT
Warning Indicators ERROR REPEAT
LINE CLEAR | TEST
1 |Graph was clipped o o o O O
2 |HPGL/2 command Error o ® O [ O
3 |Lever up or no media o ® O O O
4  |Cannot repeat o O [ J O O
5 |Communication error XX O O [ O
6 |Width sensor error XX O O O [
7  |Check media, drum or X motor o O O o O
XX = flash ® =on O = off

Warning 1 The graph is clipped

This condition indicates that the cutting graph is bigger than the cutting area.

You can solve the problem by:

1. Reload a wider or longer media.

2. Move the pinch rollers to widen the cutting area.

3. Re-scale the graph to a smaller size. Then send the cutting job again from your computer
to the cutting plotter.

Warning 2 HPGL/2 command error

If the cutting plotter cannot recognize the commands from your computer, please check the
commands applied to your cutting plotter in the HP-GL/2 or HPGL commands. Then send the
same job to the cutting plotter again.

If that doesn’t solve the problem, please contact your local dealer.
Warning 3 Lever up or no media

Check that you have lowered the lever down and make sure that you load the media before
cutting.
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Warning 4 Cannot repeat cutting

There are two possibilities:

1. There is no data in the buffer: please send the job again from your computer;
2. The buffer is full: please send the same job from your computer again.

Under both conditions, press the ON/OFF LINE key to clear the warning message.

Warning 5 Communication error

Check that the serial/USB cable has been connected to the cutting plotter and computer
properly.

If so, then check whether the interface settings are correct. Check that the communication
settings in your PC are the same as the ones on your cutting plotter (for example — 9600bps,
no parity, 8 bits, 1 stop bit). Then, press ON/OFF Line key to switch back to On Line mode.

Warning 6 Width sensor error

Check that the pinch rollers are positioned above the grid drum and reload the media again.

Note:
In order to identify the warning messages easily, please stick the warning

sticker (in accessory box) on the side cover of your cutting plotter.

6.2.2 Error Indicators

If some mechanical problems occur during the operation, the ERROR LED will turn on. Please
follow the instructions below to solve the problem. If the cutting plotter still cannot work,
please contact your local dealer and tell him or her about the error indicator.

ON/OFF DATA | CUT
Error Indicators ERROR REPEAT
LINE CLEAR | TEST

1 |SRAM error ) () O O O
2 |DRAM error [ ] O [ O O
3 |Check media, drum, or X motor o O O o O
4  |Check media or Y motor o O O O ([
N L/
/ﬁ}\=flash ® -on O = off

Error 1 and 2

Please contact your local dealer to replace SRAM or DRAM.
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Error 3 Check the media, drum or X-motor (Drum driven motor)

This message indicates that there might be a problem on the X-axis.
Please check that the drums are working normally and see that the media is well loaded. Then turn on
the power and reboot the cutting plotter.

Error 4 Check the media, or Y motor (carriage driven motor)

This message indicates that there might be an obstruction to the carriage relating to a problem on the
Y-axis.

Please clear the obstruction and check that the carriage can move smoothly. Then turn on the power
and reboot the cutting plotter.
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6.3 Cutting Quality Problems

Note: The daily maintenance of your cutting plotter is very important.
Be sure to clean up the grid drum and pinch rollers regularly for better
cutting accuracy and output quality.

Is the blade installed correctly and the blade
holder fastened securely?

Yes No

v

A 4

Is the blade dull Refer to Chapter 2.3
or chipped? “ Blade Installation”

Yes No

|
|
|
|
|
|
A 4 A 4

Replace Is tool force set up
with a new properly? (The default
blade for tool force is 80 df)

[
|
|
Yes | No
|

A 4 A\ 4

Is the tool offset set up Adjust the tool force to obtain an
properly? optimum blade force. Refer to
Chapter 4.3 “Cutting Force and
Offset Adjustment’

Yes No

A 4 \ 4
Is there any dirt adhered to Adjust the tool offset to
the blade? obtain an optimum value.

[

|

|
Yes | No

|

A 4 \ 4

Remove the Please contact your dealer for
blade and clean technician support.
it.
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Expert Il Series Specification

Model Number

EX 11-24

| EX1I-24LX

EXII-52 | EXII-52LX

Max. Cutting Width

600 mm (23.6 in.)

1320 mm (51.96 in)

Max. Media Width

719 mm (28.3in.)

1470 mm (57.87 in.)

Material Thickness

0.8 mm

Max. Cutting Force

350 g

Max. Cutting Speed

705 mm/sec (27.8 ips)
(at 45 degree direction)

635 mm/sec (25 ips)
(at 45 degree direction)

Mechanical Resolution

0.009 mm (0.00035 in.)

0.012 mm (0.00049 in.)

0.025 mm (0.00098 in.)
+£0.254 mm or £0.1% of move, whichever is greater

Software Resolution
Distance Accuracy

Repeatability £0.1mm
Tracking 3M
Memory Buffer 1 MB /500 KB (when using AAS)
Interfaces USB 2.0 (Full Speed) & RS-232
Type of Command HPGL, HPGL/2
Configurable Origin Yes
Control Panel 6 LEDs / 10 Keys
Diameter of Blade 2.5 mm
. : (H*W*D) mm 233*880*255 1065*1632*620
Dimension | \v+py in 9.1%34.6*10 41.93+62.25*24 41
Net Weight 11KG (24.31b) 53KG (116.41b)
Stand Optional Standard
( :Kg’mat'c'“'g”'”g System Available on Expert Il LX models
Power Supply 100-240 VAC, 50 /60 Hz (auto switching)
Power Consumption Max. 288 W
Operation Temperature 15°C~30°C / 60°F~86°F

Environment | Humidity 25% ~ 75%

® Compatible with Windows 7 and above & MAC OS X 10.6 and above. (*Purchasing serial
number for “Sure Cuts A Lot” software to work with Mac OS.)

® The specification and data sheet may vary with different materials used. In order to obtain the
best output quality, please maintain the machine regularly and properly.

® GCC reserves the right to change the specifications at any time without notice

® GCC certified material in tracking is Avery MPI 3000.

® The above listed specification values are effective only when operated with media certified by
GCC.
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Blade Specification

For cutting thick fluorescent and reflective vinyl. Also for cutting
detailed work in standard vinyl.

202003480G
The blade is 45° with Red Cap (5-unit package), 0.25 mm offset,

and 2.5 mm blade diameter.

R ———————

For cutting reflective vinyl, cardboard, sandblast, flock, and
stencil sharp edge.

290088080G
The blade is 60° with Green Cap (2-unit package), 0.50 mm

blade offset, and 2.5 mm blade diameter.

S —————

For cutting thin sandblast mask and stencil. The blade with
sharp angle and special design, allowing it to maneuver around

sharp corners.
The blade is 60° with Blue Cap, 0.25 mm blade offset, and 2.5
mm blade diameter.

——

For Cutting small text and fine detail. Sharp blade with smallest
offset.

265017550G

265017560G
The blade is 50° with Black Cap, 0.175 mm blade offset, and

2.5 mm blade diameter.

S ———————

For thin and delicate media such as window tint.

265017530G
The blade is 25° with Yellow Cap, 0.25 mm blade offset, and

2.5 mm blade diameter.
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About the Tool

A generic term referring to the blade that cuts the sheet, the pen that does plotting,
and the LED bombsight (option) used for pointing to the reference point.

OFFSET is the distance that the blade tip is displaced from the centerline of the
blade.

<«— Blade

<«—— Central line

Bladetip —»

i
i
i
—

« |
offset
Protrusion Length of the Blade
Thickness of
the media (t1)
Protrusion length
of the blade > I
Thickness of the .
base paper (t 2) — v
v

Length of protrusion = t1 + t 2/ 2, but for your convenience you may just make it
about 0.3mm ~ 0.5mm beyond the blade holder tip.
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The following is an example of how to output the file with CoreIDRAW.

User Instructions

1. Open CorelDRAW, finish editing all the files you wish to plot and select all the images
at once.

2. Select “Outline Pen” to adjust the outline for cutting.
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3. Adjust the value of pen width to 0.001 mm and click “OK” to save your input.
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4. Select “ File — Print” to output the file to your cutters.
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5. Choose the correct model you have installed.

zeneral |La',.-'uut |: Separations || Prepress || Misc || E=? Mo Issuesl

Pages:

Destination

one: | EEEACENN | oo
Twpe: Jaguar IY 153 Ise PRD

Skakus: Ready

Wwhere: GCCUSEO:

Comment: Print to filz [D
Prink range Copies

@ Current document "C} Docurnents

C}' CUrren. pays

Mumber of copies:

Selection

Even & Odd

f
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6. Choose the “Layout page” and click the “Reposition images to: — Bottom left corner”.
Please note that you must put your image at the bottom left corner.

| General LEYD'@EparatiDns | Prepress | Misc || a2 Mo Issues |

Imange position and size
{7 As in document

{} Fit to page
@' Reposition images to:

[*] Settings for Page 1:

Position:

Zenter of page »

Center of page
Top center
Left center

Jizet [Right center

¥ 13591 mi* & | W

138,15 (Bottom center

vi [169.07 1+ -~ | %

Top left corner
s M Top right corner

[C]Print tled pages

WEFIED, 1.0

i | | i o OF Page IO

Boktom left corner
Bottom right corner

Custom

[ Bleed limit:

7. Go back to the General page and check that your image is at the bottom left corner. Click

“Print” and get a wonderful cutting image.

zeneral |La3.-'u:uut '. Separations | Prepress || Misc | ? Mo Issues |

{} Current page

2EIECCon

Pages: | 1

Destination
Mame: aguar Iv 1583 - | Properties. ..
Twpe: Jaguar It 183 Lz PPD
Skatus: Ready
Where: GCCIJSED:
Zomment: i-'r E]
Prink range Copies

: r =
{E} Zurrent document {:} Documents Murnber of copies: 11 = |

| Iﬂ ! E Collate
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CorelDRAW Plug-In Instruction

AASII VBA Installer is applicable for Core DRAW Version 13, 14, 15, 16, 17, 18

Installation
Please refer to Step 8 in Chapter 2.7.1.2 Driver Installation to install AAS plug-in for
CorelDRAW.

Run CorelDRAW AAS Plug-in

m Run CorelDRAW to edit your graphics and select all images at once when you wish to
plot.

M Select “Tools->Macros>Run Macro.” Then select Global Macros
(GCCAASII_Draw13.gms) under the “Macros in” manual, and press “Run”.

-
Run Macro

Macro name:

GCCModule 30T A4n Plog In

GCCHModule GCOC A48 Phug In

_1 = —_ 1 —

Macroz i | GlobalMacros (FCCAARIT Draw. grn) - |

[ HE
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S1CTE Click on “Apply” and select whether you would like to add the registration marks by page
size or by object.

AAT I Reg. Mark Savhng «2.08-0]
o Auig| Paeggrn by ai Bcsn Pk By catge mow

= 4-Paint Posricn

Ly I i e (S
Tacimeea | e (121

W o “mm =50

™ Segmemial Posbonng

LE- e
| 5 mwn (3005001

] I = .
U e GO < 604)

P, of K Copes -:. {1 58

M of ¥ Comes o
="

M Now you can print out the image file with registration marks.

Note: “Add Registration Mark by Object” will be the default selection if you click on
the image whereas “Add Registration Mark by page size” will be the default one
when the blank area on the page is clicked.

You can also add a Hot Icon for the AAS Plug-in

Select “Tools—> Options> Workspace—> Customization> Commands—> Macros—>
GCCMadual.GCC_AAS_Plug_In” and Click OK.

- 1 e L ey
"~ "
&
R T T e - —
F o o 0 T il CormlDRAW XT (54-Ba) - Untitled-1
e Fe  Edit Ve Lavout driange  EFfeg
T H o= | " -
L 0.5
v = I 110
! Welcorme Spreen v - Titled-1
a
£ i
% ]
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Add Registration Mark by page size

If you tick “Add Registration Mark by page size” as shown in the figure below and click “Apply”,
your registration marks will be created automatically (please see Figure A3-1).

-

AAS 1T Reg. Mark Setting v1.02-01

Note:
1. The length setting will be in the range of 5-25mm
according to your page size.

Iv Add Registration Mark by page size
-

2. Please DO NOT make any changes to the “Origin” &
section when you choose to add registration marks by
page size as indicated below otherwise the position of
the marks will be changed (please see Figure A3-2).

Length 11 mm
Thickness 1 mim
Margin g mm

il (s
Lneg Ry cipacis = -
Wammm . ‘ I Stepl 300 mm
VEA Fiudze
[
I'.:- SRACE Flatige 91| Lt “aipuT FRICGE s il ' Y Stel:'l 300 mm
"3 4 M mudye 00
Tsirdkazi o Garer unmy dad Jlypecne dederce, Rlosdgs prad Bjden ()
T
g 37 Liruin :
Cawenarey el e - ! Mo. of X Copies | 4
et No. of ¥ Copies [
f'""- _ [ f Satvei st bor Hasoor il skl Vil b ]
g i
'u'-."-' Degn Tieh demsinns Figure A3-1
ro Hesariah |88 e i e
1 Oudednm e (1] ik & Cherve hacten
43 Figure A3-2
iins o There B Eim

The system will create the 4 marks on the 4 corners of the page as shown in the picture below
wherever you move your image.

(.n\ s i O

CorelDRAW Plug-In A-3
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Workable area
It allows users to edit and cut graphics in the area outside the registration marks when adding
registration marks by page.

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on
left and right sides and 4.5mm extended from the registration mark on top side. On the bottom
side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent
sheets dropping or any error occurred while media sizing.

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the
left side, 9mm extended from the registration mark on the right side and 11mm extended from
the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm
margin from the edge of media sheet to prevent sheets dropping or any error occurred while
media sizing.

senerdl | Cplog | Composibe | Levout | Fagpiest |t WD ESigd
Dettration
Snnger VippperiarTulF BE S8 CnDCERA P50 KX - Feh i i
arp 11 L3 . -
A Left sit
Tage bebarie s crsmriation (Landscapes -
Slarlua Delault prirdic Ky
Locabion 19, 168 100 248
C Gt Fewd o i o
¥ 1 - |
Fro cangs Copie Top fide k|
@ Cunem donsmend D uirrepats fesmber of coprs
LA et pligt I I r#‘ ‘.
| i ¥ ]
_'|.J._...|_|.| — K
r—
{0 )
— 4 ik
\ ] ftight

B & beman Up l_:||'ll|iI|

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled.
If you select “Single” mode, the media sheet will not be able to be moved back and
hence fail to be detected by front paper sensor.
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Add Registration Mark by Object

If you tick “Add Registration Mark by Object”, you will be offered three options of registration

marks as shown below.

-

AAS T Reg. Mark Setting w1.02-01

r

¥ 4 Pgint Position

Length IT

Thickness | 4
Margin | o
(" Segmental Positioning

X Step[ 5 b
Y5tep| 500 o

l { " Multiple Copies

Mo, of X Copies | 4
Mo, of ¥ Copies | 4

Figure A3-4

v Add Registration Mark by Object

mm

mm

mim

4-Point Positioning

Length: The length of marks

- Range: 5mm~50mm

- Optimized Setting: 25mm

Thickness: The line thickness of marks

- Range: 1mm~2mm

- Optimized Setting: 1mm

Margin: The distance between marks and images
- Range: Omm~50mm

- Optimized Setting: 5Smm

Segmental Positioning

X Step: The distance of intermediate position on the X axis
Y Step: The distance of intermediate position on the Y axis
- Range: 200mm~600mm

- Optimized Setting: Less than 500mm

Multiple Copies

No. of X Copies: The numbers of copies on X axis

No. of Y Copies: The numbers of copies on Y axis

- Range: 1~50. (The more copies you make, the more time
is needed for data transmission.)

- Numbers of X Copies * Numbers of Y Copies = The total
amount of image copies

Copies with outline: To show outlines of image graphics

Note: The values entered in the “4-Point Positioning” section (length, thickness and
margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies”.

CorelIDRAW Plug-In
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4-Point Positioning

-

AAS 1T Reg. Mark Setting v1.02-01

4-Point Positioning

- ® Length: The length of marks
. - Range: 5mm~50mm

: - Range: Omm~50mm
" Segmental Positioning

s R

- Optimized Setting: Smm

L]
YSEp| so0 |
" Multiple Copies
| Mo. of X Copies | 1 Figure A3-5

1 Mo. of ¥ Copies | 1

The system will create the 4 marks as shown in the picture below.

Pl el e Ly (g Blagn e (e Jae  Gpsle e e
ol = L - H & & = - . 5 s Seagha e

ALES "l
el ¥ - E miy ral—— = 0 81 ey -
r L LE rwn

= 0O O

-i 2 W €

! w X
-

|l O ealm

- A £
X i

Figure A3-6

:IV Add Registration Mark by Objgct > Optimized Setting: 25mm
ﬁ e —”®  Thickness: The line thickness of marks
Length [Tmm - Range: Tmm~2mm
Thickness | 1 mm - Optimized Setting: 1Tmm
Margin [D_mm ®  Margin: The distance between marks and images

CorelDRAW Plug-In A-3
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Note:

1. To save your materials, in addition to amending object margins, you can also adjust the
length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see
table 1 for suggestions based on different material sizes). The smaller the size is, the
smaller the distance between the object and the registration marks is (see the figures
below).

—

%
/_j,:- 7:;a to be cut

=l

."l.l

%

e

2L by

Figure A3-7 - y

\\

i Figure A3-8

C
(.

Page size Suggested mark length
(unit: mm) (unit: mm)

A6 (105 x 148) 5

A5 (148 x 210) 8

A4 (210 x 297) 11

A3 (297 x 420) 16

A2 (420 x 594) 23

A1 (594 x 841) and above 25%

Table 1

*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so
please make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the
previous setting will be applied.

CorelIDRAW Plug-In A-3
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Segmental Positioning

For precise cutting quality, it is suggested to select “Segmental
Positioning” when you are working on an extra long or
large-sized image to increase cutting accuracy.

-
AAS T Reg. Mark Setting v1.02-01

[T Add Registration Mark by page size
Iv add Registration Mark by Object

" 4Paint Position

Length I25 mm L.
T Segmental Positioning

T 1
Margin I o mm

¥ Segmental Positioning

® X Step: The distance of intermediate position on the X axis
——> @ Y Step: The distance of intermediate position on the Y axis
- Range: 200mm~600mm

XSED] 200 |y - Optimized Setting: Less than 500mm

ki StED 200 .

" Multiple Copies

No. of X Copies | Figure A3-9
Mo, of ¥ Copies | 1

The system will create the as shown in the picture below

L = P e L T I-..-h [ ; gﬁ-mgntalmp-o-sﬂlonlng

ol ! = [P H &% o

] T A s ¢ -;--/::!:
‘IH_'-I P ey

il

i,

> L I I

Figure A3-10

Segmental Positioning will be applied to Multiple Copies when the object to be copied is of large
size (with the length or width over 200mm) to increase the accuracy of registration mark
detection.
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Multiple Copies
It is suggested to select “Multiple Copies” when you would like to make several copies of one
image on your material to increase cutting accuracy.

AAST Reg. Mark Setting v1.02-01

IO
[+ Add Registration Mark by Object
" 4-Paint Position
n Multiple Copies
Length o5 mm ) ) i
| ® No. of X Copies: The numbers of copies on X axis

Thickness mim
1
[ ]
Margin 0 mm

No. of Y Copies: The numbers of copies on Y axis

- Range: 1~50. (The more copies you make, the more time is

| " Segmental Positioning needed for data transmission.)
XStep| sop o - Numbers of X Copies * Numbers of Y Copies = The total
. .
i ¥Step| sp0 ———  amount of image copies

®  Copies with outline : To show outlines of image graphics

{+ Multiple Copies

No. of X Copies [ 4 Figure A3-11
Mo. of ¥ Copies | 3

The system will create the as shown in the picture below.

Pl el e Ly (g B s Tag  Jae  Gpsl e jip

I B°R - o % B ete o - $ 5 wwhc @ -

-“:l.ri - I'. -i"d:' :::1H 1 = — I .

? —

A e B Loe L

: L - Ll LL ]

4 o iy o

Y axis — k : I LJ

: Y ¢ ¢ 9

- | L |

v —

. t o e iy W

o

Figure A3-12
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Contour cutting through CorelDraw

m Position the paper with registration marks printed by your printer on the GCC cultter.
M Select “Files>Print”.

) DoAY 3 i B’ - bl -
15 Yies fensl  OSrt  Bagh e legl (e Bpek e i
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Tajetia) Fitg [ ]
gl Bs i |
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Fuirbrty w= FIF

FE
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G, Fend P

# Toec For Ogigel

M 1 vt Preovmesns

Figure A3-13
Note: if you use CorelDraw X5 and later, you must follow the steps below.

m Click the “color” page and go to the “Color conversions performed by:” and then select
the model name of you cutter (please refer to Figure A3-14).

1N O T - ¥
l Lo LI -
. 11 e {
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" i A e
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" B e g S s s o P i k. -
e — [ - -
i, e I
 IERCRN T TR T i - i
Adngien i . o Figure A3-14
Eaeed by wride. 'HE PE RIL S L TP e e T Laded eemale Sl Gl TR 4 .
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M Go to the “Layout” page and select Bottom left corner at “Reposition images to”.

— e R i e
e -

5 L
o ¥ e

‘h © j———

o e e
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i
-_-'.l- | e - L= ]| ce== s || e |

tln IR . - ' l:.l:'l'_ﬂ]' H .
o e b " X Figure A3-15
S sl .l bl SO U BTV S L O e e DB Caseel Swsose Ted e T 9 LH

1G]] Click “Print”.
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AASII VBA Installer is applicable for Adobe lllustrator Version CS4, CS5, CS6, CC.

Installation

Please refer to Step 8 in Chapter 2.7.1.2 Driver Installation to install AAS plug-in for Adobe
lllustrator.

Printer Setting

m Go to Control Panel, right click on the printer and select Printer Properties to open
the Printer Properties page

L W - T — T
{ .I‘_I_lp;l v b Conteed Faial § Hedbwiin sl Soend & Deeami o Privkati &
i § devicd Agle § gk B w iU T EIROT bl mgd 8 i1 ST Pimy
(X0 r-'rl |_|||u ||,- STICAL
LACH P
] ir i Fanes [0
~ #A" ~4 =S 5
F_ RN Am AFEE W Adete POF -|| |r"f"F Fin e byl 2P Ri
AR KWOCERA Do 1 'Wirite
S ] FLL -0 0l gn
nni gEpney gEpITiur
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M Go to the Advanced page and make sure the “Enable advanced printing features”
box is unchecked.

o

ey RXI-1325 Properties

Pen | Paper | AAS In
General Sharing I Ports Advanced || Color Management SecL

@ Always available

1 Awvailable from 12:00 AM 12:00 AM
Priority: 1 =
Driver: RMII-1325 v || New Driver.

@ Spool print documents so program finishes printing faster

() Start printing after last page is spooled
@ Start printing immediately

() Print directly to the printer

[ Held mismatched documents

| Print spooled documents first

" Keep printed documents

[ Enable advanced printing features

| Printing Defaults... || Print Processor... || Separator Page...

lllustrator Plug-In A-4
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User Instructions

m Open lllustrator.

M Edit your image and create a contour line (Note: you must have the line width set as
0.001mm).

broam

e T 1Y
(Lt

s

[ rwyrs Loy
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m Select the registration marks needed

Step 5

Positioning and Multiple Copies.

hree types of registration marks are introduced here: 4-Point Positioning, Segmental

Fiake DY Fage siee

¥ 4-Paint Poisitioning |

Length{mm): {10~50)
Thidmness{mm): {13y

| Margin{mm): Fp=Tnt

| T ety

Segmentzl Peisitioning |

| ¥% Step{mm): sl 0N rﬂnn__r:nr)
I e e

‘ YStep(om):  EITN (500~600)

Multiple Copies |

Mo. of X Copies:
Mo. of ¥ Copies:

Note:

The values entered in the “4-Point Positioning” section (length, thickness and margin)
will still be applied when you tick “Segmental Positioning” or “Multiple Copies.”

lllustrator Plug-In A-4
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M Confirm the registration marks (the 4-Point Position mark is used as an illustration in the
following steps).

lllustrator Plug-In A-4
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S1CTek:] Hit “Edit Artboards”.
Ducu

Bleed and View Options

Units: | Points

Top

Show Images In Outline Mode
Highlight Substituted Fonts

Highlight Substituted Glyphs
Transparency

Grid Size: Medium
Grid Colors: |l Light

Simulate Colored Paper

Preset: [Medium Resolutio..! = Custom...

Type Options
+ Use Typographer's Quotes
Language: Enaglish: USA
Double Quotes; =¥ * Single Quotes:

Position
Superscript: iRl

Subscript: F

File Edit Object elect ffect View Window Help

Arthoard Presets: Letter

Name: §

%05 M cor
Fit to Artwork Bounds

lllustrator Plug-In A-4
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M Please move your mouse to the tool bar on the left when step 9 is finished and then
click “Selection Tool”.

lllustrator Plug-In A-4
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m Print out the file with the contour line and the registration marks.

P
B Fram Templsis
D =]

“pen Eaceei Fows

Rirsan e on Dradage Ll - e

ol il
Lt
L Lo, R LIES
Sarwit i Cogy. A= Chila g
el g T,
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al=Tmil+Cmie g

B wwwrt

Pliid.

S o Bl ron ot CHfice o '. " ¥
Rapsadt. " : 2 /
-
- |, it
R

[ T T Gl {=p |

STk Place the printed file on the cutter, lower the pinch rollers and then position the carriage
at the origin of the registration marks.

m Send the file to the cutter.

P, Cefe
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Fiwr Toam Tegslaln
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Browee in Bndge &N Lbee
Chose Cirle
have G+
Sawe iy it Tl G
Saww w Copy AlteCirie i
Sawn dn Termplain —
St Tor Wk Afis Shifle Tirfe 5
Seek Sehtcredl Hicei.

Apeeri LT
Place

Sarew 1ok Beraacdl D

Expafl.

Scriphi L]
Dz worrarert Sarbug Al Clwi@
Docar=wri Cclo Féoda ’
Pl Befa. Bl Ehil¥ s Chal=]
Phri. Clisil

Exnl Crie il
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M Select the cutter model, position the object in the bottom left corner.

Print Preset:  Custom

Printer: | RXII-1

Copies: |

Artboards:

Ignore Artboards  + Skip Blank Arth

Defined by Driver

Crientation:

Options

Print Layers: Visible & Printable Layers

Placement:

Scaling: Do Mot Scale

M Your job is now completed.

lllustrator Plug-In A-4
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Add Registration Mark by page size

If you want to create registration mark by page size, select the object, go to “Scripts” under
“File” and select “_AASII_Plug_In”

M
Phes Trom Templage_ Shift+ Cirda Bl
Clpen.., Cirl=D
Oipan Recent Files ¥
Beowese in Bndge.. Mg Cirda 3

Mew,,

s CRil= W

Save Cari=5
Gawe A, Shiy+ CHil=5
Sve 2 Copy. Adt+ =5
Save g Temgplate...

Sawe Tor Weln
Simwe Sefected Shcey.
Riremil F12

ARt Db

Flace

Sk Tor Migeoasit Office. .,

Export_

Seiipta EzpedleshaFlah

Fhaw Sl

Flesremans Tabuin ABa Tl b

Tick “Make by page size” and click “Apply” and the
registration mark will be created on the 4 corners of the
page automatically, sown as below.

+ Make hy Fage e
& 4-Print Posibonimg |
tengttsfny:  EENEN (a0.50)

el (N (1
P T -

Segraerttnl Fossborsg |

% Stepimm} I (oo
T-St=plmm) B imo-sco)

Note:
The length setting will be in the range of 10-50mm according to your page size.
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Workable area
It allows users to edit and cut graphics in the area outside the registration marks when adding
registration marks by page.

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on
left and right sides and 4.5mm extended from the registration mark on top side. On the bottom
side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent
sheets dropping or any error occurred while media sizing.

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the
left side, 9mm extended from the registration mark on the right side and 11mm extended from
the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm
margin from the edge of media sheet to prevent sheets dropping or any error occurred while
media sizing.

Pk Pregel  Cumtom A - |
Brrmer  Saguar TV 101 v
(2

[T Cooer 1] [ Haspri= Criesr
Cuatigrl = il [T gnara afpoand
iErapduc =

Coks Mrugaran

il re]

AR Ml

it bt d48=
Lkl ] & | Plcement; U1 K Dot I: Opt
=D Mok Gae
LT T TS I'-'."].'IIII uif Ft to Page (43 BOSER)
Llsboyn s ™ H
Tis Crevatap
L= H H
T HLL
Preil Lose= ke i Beirsttie Lawees w
Egqm., | | Peni | Carcadl || Dops |

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. If
you select “Single” mode, the media sheet will not be able to be moved back and hence
fail to be detected by front paper sensor.
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Add Registration Mark by Object

If you add registration mark by Object, you will be offered three options of registration marks.

Firstly, select the graphic which you want to add registration mark on and go to “Scripts” under
“File” and select “_AASII_Plug_In”.

kN
Sraft = Cirte N
Ciwte O

Pl
Few fromn Termplobe .
O
Cpirs Recem Fies ¥
Brawae m Bridge.. A= kel

e
el
it T
AR5
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Saee & Doy,
Sawe i Temiplale
Siwin [iar Wit
Sirvd Trletimdd Siewn

Rimvurt

A= Shill. Ciil =5

Fi2

Plece

Sarwm fer Mirioaclt Dffice..

Epart...

pestCut 1 ]

I Seiiphs | Eperbocctirian
i Flim Slesrvi *

Dipsrument Saisg.. A= [Erl=p
Make sure to untick “Make by page size” and choose one of the registration mark types
whichever is suitable.

15T
Mabeewimmli _ T
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Three types of registration marks

4-Point Positioning

4-Point Positioning
® Length: The length of marks

T [ [N RN o T
I ILRC LAY 0 LI aHLe

¥ 4-Point Poisitioning | - Range: 5Smm~50mm
- Optimized Setting: 25mm
Length{mm): (1€ ~50) ® Thickness: The line thickness of marks
Thickness(mm): r1n) - Range: Tmm~2mm

- Optimized Setting: 1Tmm
® Margin: The distance between marks and
images

Margin{mm): {0r50)

Segmental Poisitioning |

- Range: Omm~50mm
X Step(mm): m 200~600) - Optimized Setting: 5mm

YStep(rm):  EIVISN (500~600)

Multiple Copies |

Me. of X Copies: _ (1~50)
Mo. of ¥ Copies: _ (1~50)

The system will create the 4 marks as shown in the picture below.

(]

R im IS
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Note:

1. To save your materials, in addition to amending object margins, you can also adjust the
length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see
table 1 for suggestions based on different material sizes). The smaller the size is, the
smaller the distance between the object and the registration marks is (see the figures
below).

—

F_,:. | — “HJ” .;'I__ I'{ ,-\ If ) 7-»

\ o | ] __D | =

Area to be cut

/

’ rd
I. _.-I i | 'x y I
= N
Page size Suggested mark length
(unit: mm) (unit: mm)
A6 (105 x 148) 5
A5 (148 x 210) 8
A4 (210 x 297) 11
A3 (297 x 420) 16
A2 (420 x 594) 23
A1 (594 x 841) and above 25%

Table 1

*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so
please make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the
previous setting will be applied.
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Segmental Positioning

For precise cutting quality, it is suggested to select “Segmental Positioning” when you are

|-r _'|' - [T '._.'._.
u-.'-:.:rt..!-_-.:.‘.".-m:- e

W Malor by Page ire
4Pt Prisibarig |

Leng{mm]:
T'u'h'l..":!'l:ﬂl:'l"_l'

Sy an (e

W Seomerinl Pooiteeng |

T A e
¥ S -!r.|'|.| - Fi} B
F Uiy, : (ot i Ee )|

working on an extra long or large-sized image to increase cutting accuracy.

Segmental Positioning

® X Step: The distance of intermediate position on the X
axis

® Y Step: The distance of intermediate position on the Y
axis
- Range: 200mm~600mm
- Optimized Setting: Less than 500mm

The system will create the marks as shown in the picture below. Segmental Positioning

lllustrator Plug-In
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Multiple Copies

It is suggested to select “Multiple Copies” when you would like to make several copies of one
image on your material to increase cutting accuracy.

Make by Page size

4-Paint Poisitioning |

Length{mm): E
Thidkness{mm):
Margin{mm): _

Segmental Poisitioning |

¥ Step{mm): m
Y Step(mm): m

' Multiple Copies |

Mo, of X Copies: _
Ne. of ¥ Copies: _

Multiple Copies

® No. of X Copies: The numbers of copies on X axis

® No. of Y Copies: The numbers of copies on Y axis
- Range: 1~50. (The more copies you make, the
more time is needed for data transmission.)
- Numbers of X Copies * Numbers of Y Copies =
The total amount of image copies

® Copies with outline : To show outlines of image
graphics

® Margin: Space between marks; must be 0 or = 20,
no negative numbers allowed

The system will create the as shown in the picture below.
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GreatCut Plug-In Instruction

The user manual of GreatCut software is available on GCC website download area.
https://www.gccworld.com/download.php?act=view&id=20

Daowninod Aroo ¥

Download Area

Or browse by machine model

Virnd Cuttar Lomer Engrorar Lomsoer Cuttar
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GCC AASII System
Below is a step-by-step instruction of using the AAS function in GreatCut software through
CorelDRAW and Adobe lllustrator.

Edit your image in CoreIDRAW

4-Point Positioning
m Create a new file in CoreDRAW and click on the Create contour icon on the GreatCut
toolbar (it would appear automatically once CorelDRAW is open).
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M Complete contour line settings (including contour offset value) and press Calculate to

confirm.

Contour Line b4

Find Contour Color

b awirmurn gray scale pd -

£ >
Background i Eiiues
recagnition Tolerance 0O X
Accuracy: Wery high [zlower] i
[ ] Keep interior elements . .
Contour offset is the distance
Digtance and Line Guidance Extended.. between the object and the
Cortour affzet: i > contour line.
Cancel

Correr Marmnal vl AR
Contour lines will be added to the images.
L‘ aieCRARY F (fL-Swi - Udalied
[ i fewm  [eymet Okl Beph Bmagn Teyd Jebls’ Tgah  fndow | Help
CR-@8 e - B e w oM ek O F s -
@A EEm | emne WIAL na 0 s g O Al s i~ M b E
Yol E R

b ifly Linerides. 1
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Tips: Vector object to create round outline

In general for vector objects you will get better results with the outline function. You will
see the difference between "Normal" and "Round" in sharp corners. The picture is shown
as below:

o

Normal Round

1. Click the “Create outline” to create contours in a freely definable distance around text

objects.
Dutine | - T
I""lul L] "'I [T dutnemic weldng
= | Db & e
1 = C3pnes

| [T igrane masr phesces

Thytimne [ =l mpgidy comany,
LA Lif i
i~ Duiine & nine 5 |
't Al g h
Uemld SEx dE = —1lm 1
mrmber than 200 rem | Toderenoe ..l_- — '!
ik I Caacai

2. Select “Round corners” and set the value of “offset” and “tolerance.”
Offset is the value for the distance of the inline and outline from the original object.

The field tolerance indicates in which offset from the corner dot is cut respectively
rounded.
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STl Press the Settings icon on the GreatCut toolbar.

B Limn@Hias 1 il Al - Urisbled. |
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i, N et | ey

+.

L

AL, Iy @ B an

M Press the button on the right of Jog marks.

Settngs -
Tronetens Softwae OmaiCud 4 ~
Jogmaka  BOC (ARS 1T} m :
NS
Expisl Path

Mare of layer bor Jog Mars | Fagmank
T of fyar for Dutlne Chutine
Ouipad Parsmsten

Sk sways cortour ang culne semnge
Dlusang the cuf process only rarafer "Ragmask™ and “Outine” fyer [
Cinate rear e while cutting [ |

Open cutput dislog while cuting ||

] o
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MAdjust the size, object margin and line thickness of your registration marks in the

Setup-Jog Marks window and click OK.

Type |GCC (AASI) v

@ Align to selection

(
DAIign to working area
T = -
< Object Margin mm Outside corners
Line thickness 1.00 | mp Output marks {or by pressing Ctrl) °
r.'Ia:-c.XHlsmE—_‘:EED.DD mm

Max. ¥ distance 500.00 | mm Target layer ‘ ] v|

M Ensure the three items below are selected and click OK.

Settngs
Turnmystema Softwpee  OrmaiCid 4
e s GOC LRAS 1Ty
Espodd Path
Mame of layer for Jog Marks | Ragmask

ama of bayver [or Outlng: | Ousine

Setup - Register Marks X 4-Point Positioning

Size: The length of marks

- Range: 5Smm~50mm

- Optimized Setting: 25mm
Object margin: The distance
between marks and images
- Range: Omm~50mm

- Optimized Setting: 5mm
Line thickness: the line thickness

of marks

- Range: Tmm~2mm

- Optimized Setting: 1mm

Dok Parsmistam

Show sways oortour and ouilne sssngs L]
Dlusang the cuf process only rarafer "Ragmask™ and “Outine” fyer [

Crnate revar Sls while cuttirg [/]

Open cutput dislog while cuting ||

| o8 | Larsl
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S1¢:To | Click the Set Jog Marks icon on the GreatCut toolbar.
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The system will create the 4 marks as shown in the picture below.
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Note:

1. To save your materials, in addition to amending object margins, you can also adjust the
length of the registration marks (5mm minimum) when you apply the above function(see
table 1 for suggestions based on different material sizes). The smaller the size is, the smaller
the distance between the object and the registration marks is (see the figures below).

."l.l

.
'\-\.\H

—

Ilf—-*—;\;“"‘\

. ) 7_'

9 |
,,ffx:\:\v’f

" S rd
I1 f-'lll I'~ 2
Page size Suggested mark length
(unit: mm) (unit: mm)
A6 (105 x 148) 5
A5 (148 x 210) 8
A4 (210 x 297) 11
A3 (297 x 420) 16
A2 (420 x 594) 23
A1 (594 x 841) and above 25*

Table 1

*25mm is the suggested value for the registration mark length

Area to be cut

2. The size of the registration marks would affect the accuracy of registration mark detection so
please make sure the amount you enter is reasonable.
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Output
M Select both the entire object (including registration marks and the contour line) and press
the Cut icon on the GreatCut toolbar.

o A 0 ) )« Lk

fim il s Lepmd (Rpecl B Pean Top o Dbl Tgew e | el
-G8 4 Lkt O~ B HEF W S ek ) e -
- Ferer izl Myt s e o S R S R sl = R e R S
LB E AR S OFD A
b, W 1 '
E d
%
i -I- W W
a |
|I+ '
.L-‘ |
.'.. ...
;j ¥
=
I. i
A
-

M The system will activate GreatCut automatically and import the registration marks and
contour line to GreatCut.

e e
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S1CTo ] Select Output under File.
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M. Select Cut with AAS in Mode/Tool in the Output to device window.
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Complete the settings of AAS
Offset, Pressure, Speed,
Material width and so on.
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GCC..

M Click output and the object will be sent to GCC Cutting Plotter.
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Note: The difference amount Number of outputs, Number of copies, and Step count in the

Output window.

Uit

Devre

BCL Jegoar W L4

Mg fd el £505

Dulpei Prisfee | Pl

d mimo w SR e

Earmge Frulmm

Lavgts e

Wit O] ulBuls @ -SSRk
D ol calfedd B Y-dinesor
CEcaar &R DI [T

1. When Number of outputs is set as 2, the square and the triangle will be cut 1 time

Farmber vl nripzia

WonEa” O ol

2 Ve e

CTeE ST

Pt Tl Bl

BE | oy

| mep raterence pos
] M

=} Bl Kol bl

30 | rem

-1
| Fimk p %0 eFgrET

Savm nalmgm

:illlll'.l'l.': bzl
Sy TEEg m

St e

drcmimcy. SoTTe

Crgin  Hew argn

[ s

TR dr

Cancei

and then the square and the triangle will be cut 1 time at next position.

2. When Number of copies is set as 2, the square and the triangle will be cut 2 times at

the same position.

3. When Step count is set as 2, the square will be cut 2 times at the same position and

then the triangle will be cut will be cut 2 times at the same position.
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Advanced Settings

Segmental Positioning

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x
and y distance when you are working on an extra long or large-size image to increase cutting
quality.

Follow the same steps in the 4-Point Positioning section to complete the contour line setting
and registration mark creation procedures. Adjust the size, object margin and line thickness of
your registration marks and the space between registration marks by changing X, Y distance in
the Setup-Jog Marks window and click OK.

m Press the Settings icon on the GreatCut toolbar.
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M Press the button on the right of Jog marks.

Settngs ¥

E‘—w"l S gie rmaiiCid 4

dgmat  (BOCHAAST) O

Expeost Patn
Mare of layer for Jog Marks | Regmank
kama of byer for Cutlen: | Ousine
D Parsmisdan
Show sways oontour and cuiine sefings ]
[lusng the cuf process only barafer "Regmark™ and "Outine ® Byver ]
Crnate renr Sle while cutling [ |

Opeen cutput dislog while cutiing [

| o8 | Lanced

MAdjust the size, object margin and line thickness of your registration marks in the
Setup-Jog Marks window and click OK.

Setup - Register Marks *
Type |GCC (AASI) v
Segmental Positioning
(80 Bl e ® Max. x Distance: The distance of
O Algn to working area intermediate position on the X axis

Size mm > Range: 200-500 mm
ki D s ® Max. y Distance: The distance of
1.00

Line thickness

mm Output marks {or by pressing Cir) intermediate position on the Y axis

v

Max. X distance

- Range: 200-500 mm

Max. % distance

Target layer ‘ ] v|
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m Ensure the three items below are selected and click OK.
Settngs -

Turnmystoma Sobmpe  OematCul 4

Jogmads:  GOC (AAS I

Expecst P
Mare of layer for Jog Mark Ragmank
Hama of layer for Dulling: | Dutine

Chodpid Parsmistes.

Show sways oortour and ouilne sssngs L]
Crnate revar Bls while cuttirg [/]

Open cutput dislog while cuting ||

[T

M Click the Set Jog Marks icon on the GreatCut toolbar.
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The system will create the marks as shown in the picture below.

Lq. Cord DRAW 38 (- Bl « TKUZDC -Cumter, FimatCod Silletiled: | idy

Fle fdf  ffew Leymui Dbt  High femap Ted  Jeble Tgeh o ffesdce  Helip
Fe-8 4 B - B o[ o 8
Segmental Positioning

1 = & g = R o e

Wl AR N N
4, N Untiind Les

5

Follow the same steps in the Output section to output your image to GCC Cutting Plotter.

Multi-Copy

m Follow the same steps in the 4-Point Positioning section to complete the contour line
setting and registration mark creation procedures.

Setup - Register Marks *

Type |GCC (AASI) v

@ Align to selection

l::l - . . .
When you apply the “Multiple
i = Copies” function, the value that
g Ntk cmece has been set in this section will
Line =TT mm Output marks {or by pressing Ctri) till b lied
Max. X distance 600.00 | mm still be applieaq.
Max. ¥ distance mm Target layer ‘ 1. I v|
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M Click on the Set Jog Marks icon on the GreatCut toolbar and 4 marks will be created as
shown in the picture below.
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S1CT R Select both the entire object (including registration marks and the contour line) and press
the Cut icon on the GreatCut toolbar.
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M The system will activate GreatCut automatically and import the registration marks and
contour line to GreatCut.
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M Select Mode as “Cut with AAS” and input the Number of outputs in X-direction and
Y-direction and Distance between copies, please don’t press output button.

ae—————— Misinher of coplon 1 Eaap I
Mode ek e T
e e ) Stk ijsng 504 mm Lk
o | Enaiin s
Qutput Pre e [Fos | st e
Copiss spacang 200 mm |7 Wiak afier s
It Proties Sagment apacing 000 mm
Wi Wl |1 38 belors
A4S Difsal origin X Jmmg 2%
AAE Offsst orgn Y fmeg =Re il Bathiny
Pressume g -
il 2 | Search for
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Length [mm] Lt —
T = e e e e e
Muirgar of slpuls & Y-aracian .
CHRBINCE: DT Sl Ty .
Slep coum !
ACTUNBETY
Orige

S1Te ) Back to CorelDRAW, Click Multi-Copy on GreatCut under File.
P Es O 4
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S1Tek: Complete the Number in X/Y (the number of copies desired on the X/Y axis) and
Distance in X/Y (distance between each copy) settings then click OK. Confirm that the
value of Distance in X/Y must be the same with step 6.

Multi-Copy =
Mumberin X |2 =
Mumberin |2 =
Distancein X |0.00 = mm
Distancein ¥ |0 = mm
Distance to ohject
Cancel

Note: The spacing of vertical & horizontal (Offset X & Y) should be = 20mm or = Omm; users are
advised to set the Distance in X/Y as 0 mm to remove the space between each copy to
avoid the waste of materials.

M The system will create several copies of the object with registration marks as shown in
the picture below.
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M Print the Multi-Copy images out, and put the printed media on the GCC cutting plotter.

]

1]
4]

=R

M Go to GreatCut window, press Output button.
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Edit your image in Adobe lllustrator

4-Point Positioning

m Create a new file in Adobe lllustrator.
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m Complete contour line settings (including contour offset value) and press Calculate to

confirm.
comourtine N,
I Find Cantaur Eelor
b aximumm gray zcale 97 o .
1 [
Background . Ch
recogrition Tolerance | [ bt
1 P
Accuracy. [Ver}' high [zlower] ,.] Contour offset is the distance

between the object and the
|| Keep interior ele contour line.

E st

Distance and Line Guidance
Contour offset: B | mm

Contour line is now added to the object.
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Tips: Vector object to create round outline

In general for vector objects you will get better results with the outline function. You will
see the difference between "Normal" and "Round" in sharp corners. The picture is shown
as below:

o

Normal Round

1. Select the “Outline” in GreatCut option under File to create contours in a freely
definable distance around text objects.
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2. Select “Round corners” and set the value of “offset” and “tolerance.”
Offset is the value for the distance of the inline and outline from the original object.

The field tolerance indicates in which offset from the corner dot is cut respectively
rounded.

M Click Settings on GreatCut under File.
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M Press the button on the right of Jog marks.
Settngs

Tronetens Softwae OmaiCud 4

dogmadey  (BOCARS 1Ty

Cutine
k2 g LT a '
e o Alts Bl Ciie Weltlieg
Frol. Chf+P Cenwly Chuttne-Lspei
(= R Faprm
= Sty

Expecst P
Mare of layer for Jog Mark Ragmank

blama of tayer for Dulling: | Dutine

o

Chodpid Parsmistes.

Cinate rear e while cutting [ |

Open cutput dislog while cuting ||

[T

GreatCut Plug-In A-6



GCC..

Expert || User Manual

MAdjust the size, object margin and line thickness of your registration marks and click OK.

Setup - Register Marks

Type |GCC (AASI) v

@ Align to selection

(::I Align to working area

Size 25.00

Object Margin

Line thickness 1.00

Max. X distance 600.00

Max. " distance 600.00

K

HI

mm

mm

mm

mm

mm

L

Outside corners

Output marks (or by pressing Ctri)

|

Target layer ‘ ] v|

Cancel

4-Point Positioning
® Size: The length of marks
- Range: 5mm~50mm
- Optimized Setting: 25mm
® Object margin: The distance
between marks and images
- Range: Omm~50mm
- Optimized Setting: 5mm
[ Line thickness: the line thickness
of marks
- Range: Tmm~2mm
- Optimized Setting: 1mm

11l Ensure the three items below are selected and click OK.

Settngs

Eurnsystema Softmae

Name of lagsr for Jog Maros

ki of bayer for Outline

i 4

GOC(AAS 1Ty

dog mares

Espod Path

Rageeasi

Dok Parsmistam

Show sways oortour and ouilne sssngs L]
Dlusang the cuf process only rarafer "Ragmask™ and “Outine” fyer [

Comate rrir Sle while cuttirgy [

Open cutput dislog while cuting ||

ol
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S1CTek: Click Set Jog Marks on GreatCut under File.
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Output
m Select both the entire object (including registration marks and the contour line) then click

Cut on GreatCut under File.
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M The system will activate GreatCut automatically and import the registration marks and
contour line to GreatCut.
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S1CTo ] Select Output under File.
e "I"Hl'l:'.l:l'i 4 |.|||-|";|ild- {5

|

; 25
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| D
b iad
| R O

M Select Cut with AAS in Mode/Tool in the Output to device window.
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M Click output and the object will be sent to GCC Cutting Plotter

Ouip=
Dreew GOT Jacpind W LE T o e of Jyedn i -_ T e T L]
Frttele i Eniard I [] s rnsremsms gt
Urdw gl mifiLds L T
- LR TH e 0 1| e :II
et || ekl o T
- i |l = £ V] D01 & (6} e
I L =] it [ il A s
Upaage FrzFgn 5 -
Saramnc fann |+ Famrt meartuew mvipsd
RAT I e s B e 0B
kB Dl g 7 [ LL At Sy m
*raaen gl 18
Speed | ==
Mty W Pl 043 e
LT e =01 1n y
forrar 1F eepais o B deserr i
Frnan Al caETaly B 7R i
CRIRETR I e ff 6 A PR i
Eaeg g
apvEary  Harmm
lrage biwrer miigm
Mt | & charis
i =i pe pegrurizg TrE; 37m8
Fopmm Ouizsi Agnd reim O

GreatCut Plug-In A-6



GCC.. Expert || User Manual

Note: The difference amount Number of outputs, Number of copies, and Step count in the
Output window.
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sz =i pegruring TrE 3imd
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1. When Number of outputs is set as 2, the square and the triangle will be cut 1 time
and then the square and the triangle will be cut 1 time at next position.

2. When Number of copies is set as 2, the square and the triangle will be cut 2 times at
the same position.

3. When Step count is set as 2, the square will be cut 2 times at the same position and
then the triangle will be cut will be cut 2 times at the same position.
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Advanced Settings

Segmental Positioning

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x
and y distance when you are working on an extra long or large-size image to increase cutting
quality.

Follow the same steps in the 4-Point Positioning section to complete the contour line setting
and registration mark creation procedures. Adjust the size, object margin and line thickness of
your registration marks and the space between registration marks by changing X, Y distance in
the Setup-Jog Marks window and click OK.
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M Press the button on the right of Jog marks.

Settngs W
Duonmens Softwes Oealid 4
degmadey:  ((BOC{AAS T O
Expaowl Path
Hare of layer for Jog Mardes | Fagmank
ama of bayver [or Outlng: | Ousine

Dok Parsmistam

Show sways oortour and ouilne sssngs L]
Dlusang the cuf process only rarafer "Ragmask™ and “Outine” fyer [
Cinate rear e while cutting [ |

Open cutput dislog while cuting ||

| o8 | Larsl

MAdjust the size, object margin and line thickness of your registration marks and click OK.
Setup - Register Marks *

Type |GCC (AASI) v

@ Align to selection

() Align to working area | | Segmental Positioning
e 25.00| mm ® Max. x Distance: The distance of
gt Mg - Outside corners intermediate position on the X axis
Line thickness 1.00 | mm Output marks (or by pressing Ctrl) -> Range: 200-500 mm

\4

Hax. X distance

® Max. y Distance: The distance of
Facget kayen ‘ - I v| intermediate position on the Y axis

- Range: 200-500 mm

Max. " distance
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m Select the Set Jog Marks on GreatCut under File and 4 marks will be created as shown in
the picture below.
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Multi-Copy

m Follow the same steps in the 4-Point Positioning section to complete the contour line
setting and registration mark creation procedures.
Setup - Register Marks *

Type |GCC (AASI) v

@ Align to selection

(::I Align to working area

When you apply the “Multiple
Copies” function, the value that

ize

Object Margi Outside corners . . . .
= has been set in this section will

Line mm Output marks (or by pressing Ctrl) fill b lied

Max. X distance 600.00 | mm still be applieaq.

Max. ¥ distance 500.00 | mm Target layer ‘_ v|

m Select the Set Jog Marks on GreatCut under File and 4 marks will be created as shown in
the picture below.
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m Select both the entire object (including registration marks and the contour line) then click
Cut on GreatCut under File.
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M The system will activate GreatCut automatically and import the registration marks and

contour line to GreatCut.
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Shift-C

Serve B,

Serd by Emianl

M Select Mode as “Cut with AAS” and input the Number of outputs in X-direction and
Y-direction and Distance between copies, please don’t press output button.
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SRk Bjsne
Qutput Pre e | Fos fLL S iy
Copiss spacang
Madags Profled Sagment apacing
Farnmatar LU
£AS Dffsel orgn X Jmm] .00
A4S Dffsel orgn Y [ =N
Pressun [ 50
Speed |crms) L
Watensd wdth jomy 204 42
Lasigth [rmm] 12018
ummbar of dulgels @ X-drechon a
Fuﬂ'ﬁul of Gyl s Y-grasion 2
DHbanCE Do inn Soges Jrmm 00
Slep coum 1

i
i
.08 mm
200 mm
200 e
000 mm

Chtpat nes,

Eaai eh
|1} P oy Tl
9] Enalsin toct

| isable s
|| ¥inE afier 2

[¥] San bebars

iyt Seethny
| Search for

ACTUNBEF

GreatCut Plug-In



GCC.. Expert || User Manual

S1¢:Te | Back to Adobe lllustrator, Click Multi-Copy on GreatCut under File.
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S { cior Mods

S1:Tek: Complete the Number in X/Y (the number of copies desired on the X/Y axis) and

Distance in X/Y (distance between each copy) settings then click OK. Confirm that the

value of Distance in X/Y must be the same with step 6.

Multi-Copy =

Mumberin X |2

4k

Mumberin |2

4k

Distancein X |0.00

4k

mm

Distancein ¥ |0

L

mm

Distance to ohject

Cancel

Note: The spacing of vertical & horizontal (Offset X & Y) should be = 20mm or = Omm; users are
advised to set the Distance in X/Y as 0 mm to remove the space between each copy to

avoid the waste of materials.
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M The system will create several copies of the object with registration marks as shown in
the picture below.

M Print the Multi-Copy images out, and put the printed media on the GCC cutting plotter.
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File

m Go to GreatCut window, press Output button.

Edit Object Type

Mew...

Mew from Template...
Open...

Open Recent Files

Browse in Bridge...

Close

Save

Save As..,

Save a Copy..

Save as Template..,
Save for Web...

Save Selected Slices...

Revert

Place...

Save for Microsoft Office...

Export...

GreatCut 4
Scripts

MNocument Setun...

Shift

Alt

Shift
Al

Alt+5Shift

Al
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SignPal Instruction

The SignPal Software is Windows System compatible and all versions support the AAS I
contour cutting function.

SignPal Instruction Index:

[1] Installing the SignPal software

[2] Set up your GCC Cutter on Production Manager
[3] SignPal AAS Il Quick Start

[4] SignPal Features List

[1] Installing the SignPal software
To install the software, you must have Administrator privileges. To use the software, you
must have Administrator or Power User privileges. See your Windows user guide for more
information.

1. Uninstall any previous version of the software.

2. Visit GCC website (https://www.gccworld.com/download.php?act=view&id=20) to

download the WinRAR file.

Download Area

SignPal Instruction A-7
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Or browse by machine model
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iU £ e Whirsdoues £ 1T G TIBRA )

3. Follow the installation and activation instruction for SignPal below.

(1) Install and activate software on an online computer

1.Launch your browser and type https://www.saicloud.com in address bar and press
enter, then input your activation code, then click Activate, activation code can be
found in the code label in software package.

Activation Code

Piease amer e-activalion (008 18] B companed O SOfNwan [ hass

AE R s S

2. In login section, click | am new to the SAi Cloud and input your email address,
then click Create Account, an email will be sent to your mailbox.

Create A Free SAi Cloud Account

& lam a returning customer

Enter your email address to get started.

Important: The email address you select for
this SAi Cloud account will be the owner of
the software. It will be used for all SAi
software services. Itis recommended you
Use a permanent business email address.

784306662@gg.com

SignPal Instruction A-7



GCC. Expert Il User Manual

3. Check your mailbox and click website link in the email then complete the
information fields.

Create Account

FrzrameT moxt Se o aax T chwresiers

Sty Swrwesrd
o Tearms And Condrions
e Terms and Conditions
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e I -
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FRWHOHL F 70000 ST AGERE 7D T TRRMN O =)
AIFREEWVENT DN DEFH BN B SLOUN BOCTRONT AND AT B
Sa Frovnce
Ahke | DETERd TerEei
I
...................
I L [ R e o T [ =
Cramte oot
] =

Step 2. Add Software to your SAi Cloud Account

Add To SAi Cloud Account

This software license will be added to your SAi Cloud Account.

[ non |
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4. Open Autorun in the WIinRAR file. Then install software step by step by following

the wizard.
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5.Paste your code into activation code field.

i
| LN T TSy
e @ Soowamer D o o lowss

e el ST Mol RPEEE B RS T @ Aol Cood e e

1 dregr e fatna

o

——
[ . i'-uq ACRETTWISTI i

6.rSeIect_Ianguage you need, click OK and finish installation.

- Mot for resale

Product: |PhotoPRINT SERVER-PRO Cloud

Language: IEninsh

[T Install to startup items

[~ Clear Application's previous preferences
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(2) Install and activate software on an offline computer

1.Open Autorun in the WIinRAR file. Then install software step by step by following
the wizard.
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2. Record your computer ID in the dialog box below and look up your computer name,
You can find your computer name by right-click on My Computer and choose

Properties.
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Launch your browser on another online computer and type

https://www.saicloud.com in the address bar and press enter, then input your
activation code and click Activate.
The Activation code can be found in the software package certificate.

Activation Code

Please enter the activation code that accompanied your software purchase.

Activation Code || 5H4LAIINEEG_—

=
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4.In login section, click | am new to the SAi Cloud and input your email address,
then click Create Account, an email will be sent to your mailbox.

Create A Free SAi Cloud Account

i lam areturning customer

:® 1 am new to the SAi Cloud

Enter your email address to get started.

Important: The email address you select for
thiz SAi Cloud account will be the owner of
the software. [t will be used for all SAi
software services. It is recommended you
use a permanent business email address.

T84306662(@qq.com

Create Account

5. Check your mailbox and click website link in the email then complete the
information fields.

Step 2. Add Software to your SAi Cloud Account

Add To SAl Cloud Account

This soitsare Acenss will e added o your SAI Tl AcTound
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6.Click “License Manager’ can’t connect and input your computer ID and
computer name that you recorded for the offline computer before, then click
Create license Now and Download License, save license file to local.

Siep 1 - Download

Clicking on the downinad bubton Beicwr will download 5 small applcaiion Run the application to dn

Ligirdand v

Step 2 - Install

Once e download i comgdede. min the installzr, The final glep im the install procsss will wm a "Lic
apmicaion

Aep J - Litanse
The "Licends Manage appheation will g0k for an sctralbon code Use the sétrabion codé balow g

OTPSNOBEF XY UKGXHLTAR

!

Create License Current Install

Campubs |00 SE190AZEE TS

Tinn arflmsies il ls lcenisd e b used an lhe cormien sl =i
sametsl Mame JEFF-PL

=> Ugsi Blamn. Admenistmio:

Mar 21, 2014

Digenload Licsess

HreEd

Crmgiw Lorner Mow
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7. Copy license file to offline computer via a removable disk device, then import it.
o ——

L
ol ke i x B iy [l

I T e O e e ]
P e .y

Tor il Uil ey vy n my— e P— e s

FEEE T EE P TR B R MR D

| P (R T P e e g e e e gt e g

| i g 0 e I e :n_ - ¥
'} R I e e e i -
| e [ e s s o
| 3
| Py T T 00 e RO TR e e P e T 1
et il Lo e e i i ey g s s g o w1 ) B | e L
N s SS aerieanary I |
|
Dy . e yeu v b @ead o0 0 o T 9w vsmom 0 h g
s T e — s B
Ba s
| | A eww G bl o
Lo rer 14 THOSCRRRET Ny ——
L e ey by e bty sobams e i bETE 8 CERE TS 0=
e T
[,
| | L i enia
& Deport Loese Fie ey i
N aal
Fremy Sefirns L1 1
- N e B i dEsn
Ly e P i ——— L
| . | L — —
—

- o e — —

[FET T ' L L
Lamum e LI

rmpr Cme X134 B

lsmnd Tr Trui [

e L] 2w Bl

[ 4 Cheil Fox e Upslahen

i e A Liernas Frls

ik M { & Harmires Liosrier Frem Thic Coemgnae

1
Bl cae | { - == |

8. Select language you need, then click OK and finish installation.

Product:  |PhotoPRINT SERVER-PRO Cloud

L] Lo

Language: IEninsh

[ Clear Application's previous preferences
[ Install to startup items
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(3) Transfer license on an online computer

1.0pen License Manager from Start menu.

. SAi Production Suite Cloud
;% Install Manager
T Job Monitor
License Manager
QI; PhotoPRIMNT EDITOR-PRO Cloud
G PhotoPRINT SERVER-PRO Cloud

It Preference Manager

2.Click Remove License From This computer, Now you can install the software
on another computer.

" —

= e

bmme i

liares @J

Vm i Em a—w F, w—i S
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(4)Transfer license on an offline computer
1.0pen License Manager from Start menu.

. SAi Production Suite Cloud
% Install Manager
-E'TE lob Monitor
License Manager
QI; PhotoPRINT EDITOR-PRO Cloud
E PhotoPRINT SERVER-PRO Cloud

|ﬁ] Preference Manager

2.Click Remove License From This computer, then record removal code in license
dialog box.

i - ﬂ‘ v B =]

[[—— @ = @

=l e

3.Launch your browser on another online computer, access
https://www.saicloud.com and login with your account. Click License Removed
then input removal code and click Remove. After this you can install software on
another computer.
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Current Install

Computer I S5E 1304268371
ooftware Remowved’?

Lompiitar Mama' jafl-pc

Lizar Plama: Jes

Mar 21 2014 :> il i

Dipamload Licangs [ -l

[2] Set up your GCC Cutter on Production Manager

1. Open Production Manager 12
2. Choose and set up your GCC cutter.
(Note that AAS Il System only works on RX I, Jaguar V LX, Puma lll, Expert Il LX
models.)
Add Setup
Choose a device

What is the brand name of your vimyl cutter?

=S )
What is the model name of your GCC?

[z 8
GRC-23 [«
i-Craft =
Jaguar [11-101

Jaguar 11132

Jaguar 11-183

Jaguar [11-61

Jaguar llI-76

Jaguar IV-101 —
Jaguar [V-132
Jaguar [V-183
Jaguar [V-61
Jaguar IV-76
Jaguar JIF1015
Jaguar JI-1325
Jaguar JII-61
Jaguar JI-765
Jaguar JR-1015
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What do you want to call your new setup?

Jaguar V61 LX

How i your Jaguar V-61 LX connected to your computer?

GCC USB 000 \ +] | Brow:

E Production Manager

File Edit Setup View Help

Job ¥ Send

B GCC Jaguar V-61 LX@GCC USE 000 i P Tools

)
=

Files  Flexic

Resource:
Printer  Sup
Profiles

s g

Youtube Face
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3. Select File > Print Setup in SignPal Software and select the printer.

T "N

Bt View Amge Tt Eacts Biwap Mindm  Hale

N Hes DM by oo RS "
Lﬂ Open. Caete ¥ = - :-ﬁ e ﬁ m.rﬁ ‘
X Clores "8 R ST S TR WO AT
lT B FndFle
H Shvr Cirie%
EH B i Ctrbs Shit 4
| PR meart
| T Eapee
! Aczpir g " . e
‘ EX [Ciecumem Setm CedslE
Fes:
L B LF= tinl
PT" - Lar | e
N Pt Setup_ Dl Shifisl !
. Brt I:__'-I-IIILL
-
Print Setup
— Printer
MName: “wogpprinter2\4F 9T HHH FX DocuPrint R Pro

Status: Ready
Type: Microsoft enhanced Point and Print compatibility driver

Where:  4F iT3H
Comment:

—Paper Crientation —
Size: Ad ;I o

Source: | Automatically Select ;I EI £
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4. Select File > Document Setup in SignPal and select paper size .

SRR b -
= Lagrflai Bxer - [LiniHies |

_mu...r.rm.-_-uu.n_.-w..l..u.h
{1 M st B P
) ) e U £
[ﬂ ki e = : :'?Eﬁ‘nnﬁ . e
Clooe Ctid= 14l 1 i i i | i i . i i
-
ﬂﬂ
St =%
NH s S+ Tl
"Lﬁ Eapipes,
! Rz lmage (] & "
‘ﬂ Ciecume n Sftup. Cerdsl I
Resc
My carn Cirds | ex
pr L Cwy -
Priet S CaileShulte !
& - Priat Fu.2 Fruniey
Pralies
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[3] SignPal AASII Quick Start

1. Use the Rectangle Tool to create a rectangle.

L%ﬁﬁﬁﬁ X LA m e

H_J_.J_.,l |..|.I i ] Rl i 1 i

a

-

,ﬂumﬁhaa{"
_Gﬁﬂﬂﬁ&ﬁﬂﬁﬁ

i

.-.f. s B

2. Select Effect > Contour Cut. Then click ‘Apply’ in DesignCentral window.

@ File Edit View Arrange Text Effects Bitmap Window Help

PEEBRRATI LA onBEG

2 4 & 3
L e e | oo R s SOSR eee| eomi s | F e|F eens | Semey

S
0
@
|
5
D

ﬁﬁﬁ%@@ﬁﬁ-

;

E

2

DesignCentral

[

2.000in

o IE.DDEin

¥ Fropartion
[ With holes

[ Il
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3. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark.

L) SignPal Expert - [Untitled 1]
1 e,
EI File Edit View Arrange Text | Effects | Bitrnap Window Help

PARBRAT T C|eoBEBRS
il Hlll?l|l|]_ Contour Cut... -'-""?"""'IF'
k‘ Q = — J'* Contour Cut Mark...
II' Q 3] [} Shadow... \
%‘ @. i [1 Clear Contour Cut Desige
lj Q ] m'l Separate Contour Cut I"‘"I
Y K-
Z | & i
D & .
=CYE :
g bl 4
] [\
2 =

4. Select “GCC AASII” in SignPal DesignCentral window to create the AAS Il registration
marks (4-Point Positioning) and click ‘Apply’ in DesignCentral window.

DesignCentr

IF: 5 |
O
[0.030i

an--m ‘I

.
‘ \ Qal' [0.0008
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5. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental
Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please
select “GCC Segmentation” in DesignCentral window and then click ‘Apply’.

DesignCentral

it ]

ol

I 5
[ cc e
(2 [0.030m

m-m ‘I L

' | L

0.7 |0.000in

6. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple
Copies’ function is only available under CorelDraw plug-in.

7. Select File > Print to print out the image.

m‘ signpij_l'.._...l_..ﬂ.l_l:&l...l.:lj—l.__'_..—.—.:d- - J
EEi ™ New Ctrl+N ilg-
| F®  Open ciieo [P
Close Cul+F4 [3, O £ @ l:
-k,%ﬁ‘-ﬁ Find File.. IR O P
. Save Ctrl+5
Ir G @ Save As... Ctrl+5Shift+5
SE E 7 Import.. |
|:i E 5@ Export..
J‘;‘ [= Acquire Image
@ E% Document Setup... Ctrl+B
) ' F Cut/Plot... Ctrl+L
oA e ri Cut Contour...
Print Setup... Ctrl+5hift+P |
oo | M= T——— g
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-

SignPal Expert

Printer paper crientation does not match decument. Adju
automatically?

8. Set the Scale as 100% in Print page.

LT

- Prinker i
M arme: “\apprinter2\4F_TEA_ R _FX DDCL_lj Froperties...
StatLz: Ready
Type: Microsoft enhanced Point and Print compatibility driver
PostSerpt data:—  Binary ¥ ASCH
— Copies  Print Options
| | Numberofcopiess 1 =] I" Selection only
: J i3J [~ Border
1'2’_ 1:2'.— = [ wireframe
l [T Substrate
—Scale— )
™ Fit drawing to paper LR
I ™ Fit barder to paper I Gid
l o et [ Contour cut paths
T2in = 1 (100 L e rplate
— Tiling ‘
™ Print tiled pages — Position =
| Overlap: [0.000In =] JEenter ﬂ

[ Preview-

9. Load the printout vinyl on the plotter and select File > Cut Contour to send data. You
can preview the job and change cutter’s parameter settings in ‘Properties’ tab of Cut
Contour window. The Production Manager will be automatic activated to complete the

job.
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ntitled 1]

Arrange Text Effects Bitmap Window

AT L HAD

i 2
| LT

-

Lo L. 1. Select a Production Manager

% On thiz computer [Local]

" On another computer [Metwark]

i On the internet address:

e
Jodosr VBT LXERGLL USE 0 Joi States

T T———— rr———

K ?-'1
laeal

:q I:: I'H I‘l I‘u II! ﬁ.lI I.n
{24 000 x 1960 000, - B =l
e G 5]
r*"I
el |
&)
Send mode | Send naw = £
Paation &l
O [i 578, = & 155 ©
2| A
[ |=_,_;
= | B —! E'-.q
8 T R 1
Copees .'!.
FH | = L = N
I Fapeat dcb ]
Sendjob [I ] tmes A
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[4] SignPal Features List

Text

Text Tool

Arc Text

Path Text

Vertical Text
Vertical Path Text
Kerning

Break Apart/ Join

Drawing
Bezier
Freehand Drawing

Shapes

Rectangle

Oval

Registration Mark Tool
Measure Tool

Path Editing
Select Point Tool
Remove Point

Add Point
Straighten Path
Round Corner
Sharpen Corner
Optimize by Curve
Optimize by Smooth
Arc

Optimize by 3point Arc
Make Arc

Reduce Points
Close Path

Change Start Point
Cleaver

Expert

Apprentice
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Scissors

Make Right Angle
Break Path

Join Paths

Align Horizontal
Align Vertical
Align Points
Apply Length and
Angle

Remove Tiny Objects

Vector Eraser
Cleaver by Path

Working with Files
Job Info

Scanning

Achieve to Cloud
Workspaces

View
DesignCentral
Color Mixer
Snap

Arrange

Group
Compound

Mask

Guides

Contour Cut
Convert to Outlines
Convert Stroke to
Outlines

Convert Linked to
Native

Path Direction
Order

Cut Order
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Align . .
Spacing o .
Rotate o o
Resize o o
Deskew o .
Mirror . o
Step and Repeat o

Effects

Combine o

Outline o

Contour Cut o o
Contour Cut Mark o o
Shadow o

Bitmap

Autotrace o

Color Mode o

Production

Cut/Plot o o
Manual Split Lines . o
Tile All Copies . o
Panel to Border o .
Auto-weld o .
Auto-trap o o
Overcut o o
Optimize Cutting Order J o
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Sure Cuts A Lot

There are basic instructions of Sure Cut A Lot below. If you need detailed instruction, please
refer to Sure Cut A Lot Help.

1. Select the cutter you want to output and change the work area.

M Run Sure Cuts A Lot software.

| %!F___ IR ?
-Hwﬂ: :
Sz.me Cut | = =

Alob_ & e

M Select “Cutter” and select “Manage Cutters” under My Cutter to change the work
area.

Wy Capnes
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Sl R Select company / brand as GCC and select model you want to output and then click
the “<--Add to list” button.

' g L = —
i i i-‘-"wh& -
Ciittme you custerrly Save sckded e lited beiew . To add e

o i mn e

bl g Bl
ey

|

DE

| Curtts
BLLC i<Craft

l %= ALk

m Select GCC on the left and click “Done.”

e —
= e e

ColliEss i Lineely haee aide] me lansd belise. Th 5l 4
y pated A s P e Sekaded

i

T

e mmem

Sdd s Curtpe
| Cuties
| Czwgary, |
| BOEHIw
e ] 1
s

M If you want to change the material size and orientation, you can fill a proper value in
the Document window.

ad Sixe ||£I£ -

Ormntation; |Verbcs Porsat) | o«
Linit: e i

Gridines; B.00R |3

Wirkspace Alkpha;
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2. Insert Graphics from Library

m Select graphics from library to insert a selected design.

3. Draw Text

Click on the T icon at left side to create the text and select the font you like at text window.

TR

Fia filn Dy Fak s Pega [Rem Tes  des Cunan  vAsse e

HE;JHII I~ Fa [ R

2 R =
Lo 7 | v
| AR
B3 .
# T
: I L '-';‘ 2
a |

ﬁ ; I e ks q: 4
f| EEmmREE W] SERe WSS

ﬂq A RN . -I!I-I.H'.T &5 o an | 0P| =
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4. Import Design

If you have created your design in other design software, go to “import” or “place image”
under file to import it, SCA supports svg, scut, scal, pdf, ai. wpc eps, bmp, gif, jpg and png
files.

Surw oty o Lot :.rr|1rH|l:|:| T‘

[T8e]| Ldn Obgect Path  Laper Psge G

Figve Frosact Chka N
i:".'T" '."_'.ﬁ o | :l"‘l:'
oo Drot Cirl=%
I Cxum Deojert fin --,||'_-r.'-.-'.
Irripaes CirfeShik sl
I Espiiit 'llll"uh"-F
Traca Tmage Cil« EhieT

Place Imasge
CrandC it
FOE Uiwirh © coreapst

Send 1o ¥

wihagim Siorm
Shwew Propecd

Syne Iy Lihrany

Thousands of SVG files designed specifically for Sure Cuts A Lot!

v http://SVGCuts.com is the top of source for designer SVG files for Sure
Cuts A Lot. Thousands of high quality elements including: shapes for
card-making, scrapbooking, as well as gift bags, boxes and 3D flowers.
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5. Convert Image to Cutting File

m Go to Trace Image under File, or select Trace Image button on the toolbar to open
the setting window.

i

1 £da ] wt w ] :ﬂ o 'u'l'l:
(Flw] Ecdit Object Fuih - Layss  Page - Efects Tt - Wi -0

Fimay B Lt bl
Dpan Projmsi Cinle £
vt Peopect Crisk
Saew Troject Al Chil«Ehi=E
Fnpon Cirl = Shitt sl

| Faport [R
lrare lnage Carl+Thal = 1
Flacs [mage

m Click on “Choose an image” to input the image, adjust Image Settings and Output
Settings, and click OK. Then the outline of the image will be outputted automatically.

4, Trace Image

Input Output
? [ Choose an I&g ] ["/show Nedes Nodes:
:‘D“ Cat_clirl_ldds_mrtohipg Show Source Image:

El (1779 x 1118)

Image Settings o
Mode: [Monomrome v] : iy

Contrast (0-100): 1 194

A

Output Settings
Smooth (0-100); 80 =
Detail (0-100): 93 =

Single Line Threshold: O

i |:| /
—=_ S SR = | = 1 .

Note
v" The contrast and pixels of import images will affect the trace
image result. High contract graphics are recommended.
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6. Cut the Design

M Click on the “Cutter” button on the toolbar and Cut Settings window will appear.

ESUIECIHSA. Lot 4: Untitled
File Edit Object Path Layer Page Effects Text View Cutter Window

= | A

m Click on “Settings...” to open GCC Cutter Settings window.

1 el i

Note
v' The origin point is on the bottom right.

Adjust Registration Marks setting under GCC Cutter Settings window if needed.
i-’?ﬁ-.-l e

e |
PRSI 10| [ ﬁ %l..lﬁ {-!';?

*Registration Marks: set the distance between the edge of the material

and the registration marks in Mark Offset; set the size of marks in Mark
Size; set the line thickness of marks in Mark Thickness.
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MAdjust Blade Offset, Overcut Value, Multi-Cut and Quality under Cut Settings window

if needed.

*Blade Offset: set the offset value according to different blade, for a
standard blade, set the offset value at 0.25mm, 0.5mm for an optional
advanced blade and Omm for an optional plotting pen.

*Quality: associated with the cutting result; please note the better
cutting quality, the slower cutting speed.

*Multi-Cut: to repeat the cutting job at same position which is suitable
for cutting thick material.

*Overcut: allows for easier weeding and makes up for incomplete cut
lines.
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m Under “Cut Settings” section, there are some useful functions. After setting the

parameters, click on “Cut” to send the data to the GCC cutter and the GCC cutter will
start the cutting job.

CEMECn Wl
Pot; o ieind Dmiedl
T S i

[ T RwE s

CHE

Cut Mode: [W\"SIUWG

|Uze Software Speed and Pressure

Preset:

| < custom Preset >

Cardstock (120lb.)
Holde Cardstodk (2500b.)

Cardstock (3500b.)

s Pl

the values of speed and pressure manually.

pressure parameter automatically.

manually to get quality results.

*Cut Mode: there are “WSIWYG” and “Origin Point” options, WSIWYG

means what you see is what you get, the cutter will output the graphic
at same position in preview window. While with Origin Point mode, the
cutter will cut the graphic from bottom right origin point of the material.

*Use Software Speed and Pressure: tick this section, and you can set
*Preset: select a proper material to apply the preset speed and

*Speed & Pressure: you may adjust values of speed and pressure
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7. Print and Cut Your Design

The Print and Cut function allows you to print the graphics from Sure Cuts A Lot to printer,
and then put the printed materials on the GCC cutter to cut out the contour of printed jobs
from Sure Cuts A Lot.

m Open an image file in Sure Cuts A Lot.

ihﬂﬂ.l*l.-.r_
...... =
Tds Bl Dhess Fal Lags fege Tfecm Tear Wiss D

m Click on the Cutter icon on the toolbar, set the parameters and click on “Print+Cut” to
add the registration marks and print out the image.
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S1:1e ] Click on “Print...” to open printer setting window and click OK.

/

O

M Load the printed media to the GCC cultter.

m Press “Next” and then press “Scan+Cut”, and then the GCC cutter will detect the
registration marks and cut the contour lines automatically.

i fmEioe the Cormmege mm it
& in wear e Berl prinies
mark at ihe =e-
o v [
LR L B whae il
Haghi Bran
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est Connection function can save your materials.
v Click on “Test Connection” to exam if set the connection properly.

i General

GCC
| Maodel: [Jaguar v ']
Connection: [USB v]
Port: | <Auto Detect> -] (&)
Cut Settings
Cut Mode: [WYSIWYG v]
IUse Software Speed and Pressure [CIMirror H - [ Mirror v

End Action: |Rewind to origin |

Preset: [Cupy Paper "]
Holder: [R.egular Blade (0.25 mm) *]

[BJade!Pen Prompt v]

Speed: T} - 15cmfs

This will attempt to mowve the rollers or blade a short distance bac

If you do not see the rollers or blade move, double checdk the cor
make sure the cable is not loose and the power is turned on.

This test will not lower the blade and will not cut anything.

Ly

[P R TS R 1

T
[ =

12 3 4 5 6
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